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Section 1: File Tasks and Views

In this section you will learn how to:
· Navigate with My Computer XE "My Computer" 
· Perform basic tasks with My Computer XE "My Computer" 
· Change views with My Computer XE "My Computer" 
· Use the My Places toolbar XE "My Places Toolbar" 
· Use file formats
· Use file properties
· Use AutoSave XE "AutoSave" 
· Set save options
· Use templates
· Access XE "Microsoft Office Project:And Microsoft Office Access"  a custom template
· Use and save template previews
· Open a new window
· Arrange windows
· Hide a window
· Unhide a window
· Split a window
· Use multiple views
· View tables
· Sort XE "Sort Command"  information
· Use filters and AutoFilters
Lesson 1.1: Using My Computer XE "My Computer"  within Project

An important part of using any application is the ability to find, organize, and save your work in the most efficient way possible. This certainly holds true when it comes to working with Project 2007.

As you probably already know, you can open files in Project in a number of ways. You can double click directly on a file icon to open it (provided it is a Project compatible file type). If the file name is available in the recently used list, you can open it by simply clicking on its name. Finally, you can use the Open dialogue to navigate to the location of a particular file, and then select and open it. 

When you use the Open dialogue or the Save As dialogue, you will notice a panel of controls on the left hand side. 
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This control panel is known as the My Places toolbar XE "My Places Toolbar" , and in this lesson, you will learn how to work with the controls on the My Places toolbar XE "My Places Toolbar" . 
You will learn how to use and organize the My Places toolbar XE "My Places Toolbar" , as well as how to navigate with My Computer XE "My Computer" , how to perform basic tasks using My Computer, and how to change views with My Computer.

Using the My Places Toolbar XE "My Places Toolbar" 
When you display the Open or Save as dialogue box, you will see the My Places toolbar XE "My Places Toolbar:Components of"  on the left.
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Some of the default components that you could see on this toolbar are:

	My Recent Documents
	A list of recently used, completed, or accessed files.

	Desktop
	A list of navigable links that can also be found on your desktop.

	My Documents: 
	Provides access to the folders and files in your My Documents folder.

	My Computer XE "My Computer" 
	Provides access to the disk drives on your computer.

	My Network Places 
	If you are on a network, this button can display the remote locations accessible via your network.


These buttons provide access to the various drives, folders, and remote locations on your computer and computer network. In addition, the My Places toolbar XE "My Places Toolbar"  can be populated with specific folders of your choice for quick access.

To add a folder to the My Places toolbar XE "My Places Toolbar:Adding folder to" , first use the Open dialogue box to open the appropriate location (where the folder you want to add is kept). 

When you see the folder in the main viewing pane of the dialogue box, click on it to highlight the folder icon.
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In this example, the Intermediate folder is highlighted. Now, if you right click on the My Places toolbar XE "My Places Toolbar" , you will display a menu that looks like the following.
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You can see that the highlighted folder is now available to add to the toolbar by clicking the Add ‘folder name’ option at the top of the menu. (In this case, the folder in question is the Intermediate folder.)

Clicking the Add ‘Intermediate’ option will add this folder to the toolbar. You can use this option to add as many folders as you wish to the toolbar (but not individual files). 
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Here is the Open dialogue box, with the intermediate folder now available near the bottom of the My Places toolbar XE "My Places Toolbar:Changing icon size" . If you click the Large Icons option on the popup menu (remember, the menu is displayed by right clicking on the toolbar) the toolbar icons will be increased in size. If you click the Small Icons option on the pop up menu, the toolbar icons will be decreased in size.

	Large Icons
	Small Icons
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If you select a folder that you added to the task bar, and then right click to display the pop up menu (or, just right click on the folder in question) there will now be a Remove  XE "My Places Toolbar:Removing icon"  option available. If you click this option, the selected folder will be removed.
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If there are too many icons on the My Places toolbar XE "My Places Toolbar:Scrolling through"  to be displayed at once, you can scroll through the available icons by clicking the small arrows at the top and bottom of the toolbar.
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If you right click on a folder that you added to the toolbar, or one of the default toolbar buttons, you will see a move up and a move down option. The Move Up option will move the particular folder or button in question up the toolbar, so that it will switch places with the folder or button above it. Clicking the Move Down option will move the folder or button down one position.

Here is the My Places toolbar XE "My Places Toolbar:Moving icons"  before and after moving the My Documents control. 

	Before
	After
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Remember that any changes that you make to the My Places toolbar will be visible throughout Office 2007. (This means that your changes will be implemented in the Open or Save dialogues in Word 2007 and other Office 2007 programs.)
Navigating with My Computer XE "My Computer" 
If you click the My Computer XE "My Computer"  icon in the My Places toolbar XE "My Places Toolbar:My Computer icon" , a list of disk drives and folders will appear in the main viewing pane of the dialogue box that you are using. These drives and folders can provide access to pretty much any file or subfolder on your computer.

For example, in the following image you will see an option called Local Disk (C:) in the main viewing pane of the Open dialogue box.
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Take notice of how the My Computer option has been selected on the left panel (highlighted). The options you see in the main viewing pane are storage devices and folders associated with your computer system.

If you double click on the Local Disk option, you will populate the main viewing pane of the dialogue box with the folders and files that are stored on your main disk (main hard drive). If you double click on one of the folders, you will see more subfolders and files. You can use the My Computer XE "My Computer:Browsing"  option to browse to just about any location on your computer, by double clicking folders, and sub folders, and so on, until you find the file that you are looking for.

In the upper right corner of the dialogue box, you can find additional controls.  XE "My Computer:Toolbar" 
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You are probably already familiar with the close button in the upper corner. Clicking this button will close the dialogue. 

If you click the Back button ([image: image14.png]


) you will navigate back one level. In other words, if you double click Local Disk to show a list of subfolders, and then you double click a subfolder to show what its contents are, you will have changed the contents of the main viewing pane twice. Each click of the back button will take you back through one pane (list of contents) that you have previously explored. You can use the back button to move all the way back to the original list of drives and folders that you started in. 

The Up One Level ([image: image15.png]


) button is similar to the Back button. If you click it, you will move to the folder or directory that is one level up from your current location. Just like the Back button, you can use the Up One Level button to navigate back up through the levels that you visited. However, there is an important difference between these two navigation buttons. The Back button will take you back to the previous list of options, whether it is moving up a level (from a subfolder to a parent folder) or down (from a parent folder to a sub folder). The Up One Level button will only move up. That means it will only move up to a parent folder from a sub folder or file; not the other way around. 
You can also access the contents of optical storage media (CD drives or DVD drives) by clicking the My Computer XE "My Computer"  control.

Performing Basic Tasks 
Now that you know how use My Computer XE "My Computer"  to navigate though the folders and files on your system, there are a few more tasks that you should learn about. 

If you display the Open, or Save as dialogue box, you will see a panel of buttons in the upper right corner of the box. 
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If you highlight a file or folder in the main viewing area of the dialogue box (by single clicking it) and then click the Delete button ([image: image17.png]


), you will delete the file. Before the file is deleted, you will see the following alert.  XE "My Computer:Deleting files from" 
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If you click Yes, the file or folder in question will be deleted. If you click No, the deletion will be cancelled.

Another button available for use is the New Folder button ([image: image19.png]


). Clicking this button will display a small box requesting a name for the folder.  XE "My Computer:Creating new folder using" 
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If you enter a name for your new folder and then click OK, a new folder with the name you provided will be created, and the dialogue box will automatically open the view to this new folder. 
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If you click the Up One Level button, you will see that your new folder is now an item or subfolder among the contents of the parent folder. 

[image: image22.png]) termedate

@ @ X@wHE-

@ vesicon

wy
2 Conputer

oy Netwerk
pces

wy
O cuments

[CExcel2007i_Exercises.
[ Finishede xercices

FigFoider

Sereenshats





If you right click on an item in the viewing area of the dialogue, you will display a menu with several options.  XE "My Computer:Context menu" 
[image: image23.png]r
@H 9-0d- B0k - Microsoft Excel e

Sheet | Inset  Pagelayout  Formulas  Data  Review  View @ - 8
T
& ﬂ 4

Bt fom o faa] I - B

s Jpllleeirio el vl e DTS | el e B 1% sona rnas
S < (=] |= J Formatting - as Table ~ Stles~ || EFormat ™ | 2 Fier~ select~
Clipboard Font f Alignment ) Number f Style Cells Editing.

<

Lookin: [ (5 ntermediate

[0y M Recent (C)Excel2007i_Exercises
Documents | | FirishedE ercices.

(@ veskion Select

o open
3 Crputer Explore

iy Hetwork -
)=l Search.

an Shring and Security.
Dosuments Bddto archive,

Baddto MyFolder.rar”

B Compress end emal

B Compress to "MyFolderra” and email

Qwinzp »

Scan with Norton Antiirus
Send T

au

copy
Paste

Create shartcut

Delete

Rename

Propertiss

"4 v ] sheet1 /Sheet2 “Sheet3 /¥ AN i i " il m
Ready | ©

start G Excel20071_guide - i B e





The options that appear on this menu may differ slightly from system to system, depending on what software you have installed on your computer. Regardless of the configuration of your computer, you should see options to copy, delete, and rename the folder or file that you right clicked on. If you want to perform any of these tasks, simply click the appropriate item from the pop up menu.
Changing Views

When you display the Open or Save as dialogue, you will see a view button in the upper right of the dialogue box window. 
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If you click the small arrow next to this View button XE "My Computer:Changing views in" , you will display a drop down list of view options that you can apply to the items in your dialogue box.
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If you select the Thumbnails option, the items shown in your dialogue box will appear as thumbnails.
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If you select the Tiles option, the items displayed will be arranged in rows and columns.
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If you select the Details option from the Views menu, there will be additional information details included with the folder items (such as Type and Date Modified).
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If you select the Preview option, half of the viewing area of the dialogue will show you a preview of the selected file. (This will only work if the type of file that you are examining supports a preview.)

[image: image29.png]Look

) Intermedate

@ vesicon

My
2 Coputer

iy
st

iy Recene
O ocuments

y Netwerk
e

Name

see | Type
3B GIF Inag

Add My Documents'

Remave
Mave Up

Rename

Large Ieons

File pame:

Files of type:

Al Fis (%)





The best idea is to try out all of the different views until you find the one that is most appropriate for you. Remember that you can switch to any other view whenever you wish, by using the view button options.

Lesson 1.2: Saving your Files

In this lesson you will learn some key concepts related to file management and saving your Projects. Specifically, you will learn about the AutoSave XE "AutoSave"  feature, file properties, and file formats. These topics are important because your data is valuable and should be managed wisely.

In almost every instance where you are using a Project 2007, the end result will be some kind of file, which leads us to the concepts covered in this lesson. For example, the format of a saved file is important because it can influence what programs the file can be used with. The properties of a file are important because they can reveal specific information that can help you find and identify your files. Finally, AutoRecover can be an invaluable feature when it comes to recovering files after system crashes or power failures. 
Using File Formats
First, let’s talk about the different ways we can save a file XE "Project Files:MPP Format"  in Project. A file format is a way that data is encoded and organized in a file. It makes sense that a Project file (which uses the extension .mpp) would be organized and encoded much differently than a picture file, like a .jpeg.

To choose a different file format, click the File menu and click Save As, like you normally would to save a file. Then, choose your format from the Save As Type drop-down menu, like this:
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Once you’ve chosen a file type, give your project a name and pick its location like usual. Then, click Save to complete the operation.

Here’s a list of files that you can save directly to with Project 2007:  XE "Project Files:Supported formats" 
	.mpp
	Project’s default format. Note that you must choose the second .mpp type for your project file to be read in older versions.

	.mpt
	Project template format

	.mdb
	A database format that can be opened by Microsoft Access XE "Microsoft Office Project:And Microsoft Office Access" .

	.xls
	A spreadsheet or PivotTable XE "PivotTable"  that can be opened by Microsoft Excel XE "Microsoft Office Project:And Microsoft Office Excel" .

	.txt
	A plain-text sheet that can be opened by virtually any application.

	.csv
	A Comma Separated Values file, which can be opened by virtually any spreadsheet application.

	.xml
	An Extensible Markup Language file, also used to create Web sites.


Some file formats may not support all of the features you have in your project; if this is the case you will get a warning when you try to save to that format. This warning will let you know what aspects will be changed, and it’s up to you if you want to continue.

Understanding file formats can be important when opening files as well as when saving them. In the Open dialogue, there is a series of options in a drop list labeled Files of Type.  XE "Project Files:Opening" 
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The items that appear in the main viewing pane of the Open dialogue box will depend on the type of file that is specified in the Files of Type drop list. For instance, if you are looking for many different types of project files (like templates or projects), you may want to choose the Microsoft Project Files (*.mp*) option. This will restrict the files in the viewing pane to those with extensions that signify Microsoft Project files. 

If you are unsure of the file type you are looking for, you can always specify the All Files option to show all of the files in a given location, and then choose the appropriate folder or file by name.

Using File Properties
File properties are important for a number of reasons. You can view the file properties to get useful information about the file without having to open the file itself. You can specify file properties to contain specific information that will help you maintain and manage files. You can also specify properties to be used as keywords when you are searching for a file. File properties can tell you the size of the file, the date the file was created, the date the file was last modified, and what application is most appropriate for the file.  XE "Project Files:Properties" 
To view the properties of a file without opening it, right click on the file icon in Windows Explorer and select Properties from the menu.
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This will display the General tab of the Properties dialogue for the file.

[image: image33.png]temp Proj

.mpp Properties

General | Custom | Summary
&} j temp Project.mop

Type of le:  Microsaft Offce Project Document
Opens with: ] Microsoft Office Proje

Location:  Ci|Project2007\Intermediate
Sie: 137 KB (140,800 bytes)

Sesondski  140KB (143,360 bytes)

Crested:  Today, August 22, 2006, 02:41:47 PM
Modfied:  Today, August 22, 2006, 02:41:48 PM

Accessed:  Today, August 22, 2006, 03142115 PM

strttes:  Clkeatenly Clridden





You can see the name of the file in the title bar of the dialogue box, in front of the word Properties. (In the previous image the name of the file in question is “temp Project.”)
You can also see the name in an editable text field near the top of the dialogue.
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You can enter a new name for the file in this text field or edit the old one. When you press your Enter key or click the OK button, the file will assume whatever name is in the text field.

Further down, you can see a description of the file type and the program that is the default choice for opening the file.
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As you can see, this particular file is a Microsoft Office Project Document, and it will be opened with Project 2007 if you double click on the file icon.

If you click the Change button, you see a list of other programs that you can select from to open this file. If you change the program that opens this file, and then double click the file icon, the file will be opened with the new program. (This is one example of where it is good to know what file types are compatible with what programs.)  If the program is not designed or suited for the particular file type that it is opening, strange and unexpected results can occur.

Further down in the Properties dialogue box, you will see information as to the location of the file, the size of the file, the creation date, when the file was last modified, and when it was last accessed.
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This information can be helpful for identifying a file when you have forgotten what it is called (or perhaps unintentionally renamed it).

You will also notice two check boxes at the bottom of the Properties box (under the General tab) that are labeled Read-only and Hidden. If you put a check in the Hidden checkbox, the file icon will not be available when you look at the contents of the folder that contains it. 
(If a file is hidden, you can make the file visible by choosing Tools and then Folder options from the menu bar in the folder that contains the hidden file. This will display the Folder options dialogue. Under the View tab, select the radio button labeled Show hidden files and folders, to make any hidden files visible.)
If you put a check in the Read-only checkbox in the File Properties dialogue, the file will become a read only file. This means that if you open the file and make a change in the data, you will not be allowed to save the file under the same filename. The file can only be read, not written to. 
If you click the Advanced button on the bottom of the General tab in the file Properties dialogue box, you will see an Advanced Attributes box.
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In the advanced box, you will see options to allow indexing of the file for better search performance, to compress the file to save disk space, and to encrypt ( encode) the file to help secure the data. 

To view the properties for your file from within Project, click the File menu and click Properties. You’ll see the dialogue shown below.
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This first tab (General) cannot be edited. It tells you the type, location, and size of your project. It also gives you the name of the file, when it was created, modified, and last accessed; and shows you its Windows attributes (Read-only, Archive, Hidden or System).

The next tab, Summary, is editable. This window will show you the title, subject, author, manager, company, category, keywords, comments, and hyperlink base for your project. Most of these will not be filled in by default; the Title field will be filled in after you have saved your project, and the Author and Company fields will be filled in according to the information you provided when you installed Project. You can click in any of the white text boxes and add, change, or delete information.

At the bottom of the Summary window, the Template field tells you what template was used to create the file. As well, you can check Save Preview Picture if you want to be able to preview your project when using Thumbnail view.  XE "Project Files:Saving preview picture" 
The third tab, Statistics, contains statistics about your project. These are automatically filled in by Project and cannot be edited. This will tell you when it was created, last modified, last accessed, and last printed. It will also display who edited it last, how long they worked on it for, and what revision number it is. 

Tab number four shows you basic information about your project, including its start, finish, duration, work, cost, and percentage complete. 

The last tab is Custom. You can use this tab to add a variety of custom properties to your project.
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First, type in its name or select a name from the scrolling menu. Then, choose the type (Text, Date, Number, or Yes or No). Next, type in the value for that property and click Add. Your property will display in the bottom portion of the screen. This can be an easy, consistent way to track facts about a project, such as who it was checked by, which office it belongs to, or which employee typed it.

Once you’ve modified your file’s properties, click OK. (Of course, you can also click Cancel to discard your changes.) You can go back into your file properties and make necessary changes at any time; remember that fields like Title will change automatically if you save the project with a different name.

Using Auto Save
Microsoft Project 2007 is a great program—when it works. By now, you’ll probably have discovered that Project (and Windows) doesn’t always work as they should. Murphy’s Law states that Project will blow up or Windows will crash just as you’re finishing up that key project that has taken four hours… and that you’ve forgotten to save. Oops!

If something like that happens, Project may be able to recover your project. First, you should make sure that the AutoSave XE "AutoSave"  feature is turned on. (If it’s not on when Project crashes, your project will probably be lost.) 

You can find the AutoSave XE "AutoSave"  option by clicking the Tools menu, clicking Options, and then clicking the Save tab. 
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In the sample above, you can see where you can turn AutoSave XE "AutoSave"  on. You can also tell Project how often you want it to save AutoSave info by typing a number in the text box. (In the sample, the number is set to 10, so it will record AutoSave info every ten minutes.) And, you can tell it to save all open project files or just the active project.

Once you have AutoSave XE "AutoSave"  information set, if Project or Windows crashes, you will see a task pane when you re-open Project. This task pane should list all the files you had open when Project crashed, and the various versions of those files. 

You can right-click on any file in this list to open the file, save it, or delete it. You can leave the task pane open while you view the different versions of your file until you determine which one you want to keep.

You may also see this pane if Project detects errors in your file while opening it. If this is the case, you can right-click on the repaired file and click Show Repairs.

Setting Save Options
Other options for saving files are in a different spot than you might expect. Click the File menu, click Save As, click the Tools button, and click General Options.
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The following dialogue will appear:
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You can choose to always create a backup of your project XE "Project Files:Creating backup automatically " , to protect it with a password, or to open it as read-only. These options can be changed at any time, and are a great way to protect your project XE "Project Files:Protecting with password" !

Lesson 1.3: Using Templates

A Project template XE "Templates:What are?"  is a pre-formatted project that can contain sample tasks, resources, calendars and other project elements. Because some of the set up work is already done, Project templates can be a great starting point and a great time saver! Moreover, they can be reused to start many different projects.

In this lesson, we’re going to look at how to open, create, edit, and save templates. We’re also going to look at using and saving template previews.

Opening a Template
To open a Project template, click the File menu and click New. Then, in the New Project task pane, click On Computer.  XE "Templates:Opening" 
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(Notice that Project also offers links to templates on Office Online, as well as templates that you recently used. Just click the link to find or open templates from the source of your choice.)

Once you click the On Computer link, you will see this dialogue:
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Under the Project Templates tab, choose the project that you want to use and click OK. It will then be opened in Microsoft Project, ready for you to customize.  XE "Templates:Using" 
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You should notice that there is a Templates on Office Online button available in the lower left of the Templates dialogue. Clicking this button will open a web page in your browser with links to various types of templates.  XE "Templates:Online" 
Creating a Template
Although Project comes with a number of pre-defined templates, you may want to create your own template for projects that your company frequently undertakes. For example, you may want to use the same template for planning your annual report, as the tasks, resources, and schedule will be the same year after year.

To create your template, first create your project. You can work from a blank project, an existing project, or a Project template. Remember to keep the elements general so that they will apply to every project of this type.  XE "Templates:Creating" 

Then, click the File menu and click Save As. In the Save As type menu, choose Microsoft Project Template (.mpt).  XE "Templates:File type" Then, pick a name for your file and save it.
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You will then be prompted as to what information you want to save in your template.
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Check the boxes for information that you don’t want saved in the template, and when ready, click Save.

Accessing a Custom Template
You may have noticed that you didn’t have to specify the location for your template. By default, Project places the template in the same folder that contains the pre existing templates that come with Project. To use a custom template, just open the Templates dialogue box from the New Project task pane as explained before.  XE "Templates:Opening custom" 
Under the General tab, you’ll see your template:
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Now, you can access it like a Project template: select it, click OK, and it will open in Project 2007, ready to be used.

If you saved your template in a location other than the default, you can use the File - Open command to open the template. Just change the File Type to Templates or to Microsoft Project files (*.mp*) to see the project files available.
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Using and Saving Template Previews
There’s a neat feature in the Templates dialogue box that’s called Preview. However, by default it is turned off for all templates. To enable a preview for a template, first open the template file in Project using the methods discussed previously. Then, click the File menu and click Properties. Next, click the Summary tab.  XE "Templates:Previews 
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Check the check box in the lower left (Save preview picture) and click the OK button. Next, make sure you save your template and close the file. Now, the Template Preview feature will work. (The preview will show you whatever view was last used for that template.)
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Lesson 1.4: Viewing your Files

Part of Project 2007’s power lies in its ability to change screen views, so you can see your information in different ways. In this lesson, we’re going to learn how to use the Window menu XE "Window Menu"  to arrange your projects and views in a way that best suits your needs.

Opening a New Window
The first command on the Window menu XE "Window Menu"  lets us open a copy of our current project with any view we would like. Just click the Window menu XE "Window Menu:New Window command"  and click New Window. You’ll see the dialogue shown below.
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From the top section of this window, you can choose the project that you want to view in the new window; all projects currently open will be listed. Then, at the bottom, you can select the view type. Once you click OK, the command will be performed. The new window will be marked with a :2 to indicate that it is a copy of the first window.

[image: image53.png]‘@) B Edt ew et Fomet Toos Proect Repott Colaborate Mindow bep
DEHSY & 8
i [Tasks| - Resowces - Trak - Repot -

& 2 . show~ o B 2

Sunday Monday Tuesday Wednesday Thursday Friday Seturday
e T z B i 5 G

Commercisl Construction, 344 days
(Feceive nafce o proseed and sign contat, 3 days ) | (Gubm bond and msuance documents)

C O hling peks, 4 days

(ki iy 13 | (Gutmt shop avawings s o ang ea

Installtemporery power, 2 days

- B & i i 1 1

Commercisl Construction, 344 days
(Frepare and subi projet sshedile, 2) | (Pepare and s seheaue of vaes)
Ghain buing peris, 4 deys e Sk relminary shap dravings, 2 wis
Sk shop oraings and order fng lead ems - seel, 2 ks
C St sk ofe, 3 days e Setine s grace benchmares, 3 davs
14 s i iy i@y E

! Construction, 344 days.

Uk prefiminary shop dravings, 2 wks

Skt Sh drevings s rder fong ead s - el 2 wis )]

Setine o grede benchmarks, 3 days) | (repare sie - fay down yard ana temgs)

B 3 E = £ 5 % # 7
Commercial Construction, 344 days
(bt shop crawings and order g ead ems  raoing, 2 whs

St prelminary shop drawings 2 wis ) Sufi hop dravings s rder fong ead fems - devator, 2 wis

C
(Subot shop arewings o oer ong e tems - plambng, 2 ks
(bt shop srawigs s sder fang o ems - st 2 viks





Because Project 2007 knows that this is a copy of the first window, any changes that you make in one window will be reflected in the other.
Arranging Windows
If you have more than one Project window open, you may want to arrange them so that you can see all of your windows at the same time. To do this, click the Window menu XE "Window Menu:Arrange All command"  and click Arrange All. You’ll see your Project windows tiled like this:
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To further refine your view, use the document controls at the top of the upper window to minimize, maximize, or close that window XE "View Commands:Minimize, maximize, and restore" .
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You can also resize  XE "View Commands:Resizing " the windows by dragging the edges of the window border with your mouse. Moreover, you can reposition a window by clicking and dragging on the title bar.  XE "View Commands:Moving "  
The following image shows two re-arranged windows on the same project.

[image: image56.png]Type a question for help

Ele Edt Vew Insert Fomat Toos Project Report Colaborate Window Help
NEHST Bn 9 -8 Q@i » £ show |[3]

10

F - B

(Prepare and subn project schedtie,2)
bfsin bulding permits, 4 days )

Selup ste office, 3 days

14 i it

o Dec 31,06 sen7, 07 Jan 14,07
TT[F IS5 [M[TW[T[F ]SS MIT W[T[F[S|S M T WT]
ercial Construction 344 days A — A —
e story Offce Buiding 344 days —
eneral Conditions 17 days S S
Receiveiccloproce 3dars 3,G.C. general management
S bond andinsura 2y 3-6.C_project management G.C. generd
Proparc andsumi o, 2y 3 G.C. project management
Propere and subnd ot e | & commercial Construction:2
Ottamngents | days
Submi preimnry shor| 2wk [ tonn [ week J[ cwton ]
Suomit morirly request + day () (»][ January 2007
ong Lead Procuremen 70 days Sunday Monday Tuesday Wednesday Thursday Friday a
S shop drawings: 2wk st Tt
St srop wawngs | 2wk
St srop wawngs | 2wk Receive ol o procesd o Sn corract 3 days ) | (S bond s eirance documerts)
Submit shop drawinas. 2.0ks Obtain building permits, 4 days

i

(Prepar and subn s

Ukt shap drawings and order long lead fems - steel, 2 ks

17

Gubmitmorthy 18) | (Gubmt shop arawings &
Installtemporary power, 2 days

i

1

chedule of valies)
Ukt prefiminary shop dravings, 2 wks

Seline snd grade henchmarks, 31

¥ [




Hiding or Unhiding a Window
You can also hide a project window by clicking the Window menu XE "Window Menu:Hide command"  and clicking Hide. Now, the window will be completely gone from your taskbar and Window menu XE "Window Menu"  list. However, you can unhide it by clicking the Window menu XE "Window Menu:Unhide command"  and clicking Unhide. 
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When you choose the Unhide option, you will see the following dialogue.
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Just select the window that you want to view from the dialogue’s list and click the OK button to unhide it.

Splitting a Window
You can add more detailed information to virtually any window by clicking the Window menu XE "Window Menu:Split command"  and then clicking the Split option.
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For this image, a particular task was selected, so the Task Form view appears at the bottom of the screen.
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This feature can be useful when using multiple views, which we’ll discuss in the next lesson.

To remove the split, click the Window menu XE "Window Menu:Remove Split command"  and click Remove Split.
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Lesson 1.5: Advanced Views

Now that we know how to manipulate Project windows, we’re going to devote this lesson to working with views in individual projects. 

In this lesson, you will learn about multiple views, viewing tables, sorting information, using Filters, and using AutoFilter XE "Filters:AutoFilter" .

Using Multiple Views

Views are one of the most flexible components of Project. You can even use two different views at the same time! To do this, click the Window menu XE "Window Menu:Split Command"  and click Split. 
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Next, click with your mouse to place focus on the portion of the window that you want to change. When you have done this, click the View XE "View Commands:Using multiple views"  menu and choose the view option that you want.
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In the image above, the lower part of the Project screen is clicked for focus and the Network Diagram view option is selected. This action will result in two different views being displayed simultaneously: the Gantt chart view and the Network Diagram view.
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You can resize  XE "View Commands:Resizing views" these views as you require by dragging the center bar that separates the two panes with your mouse. You can combine views in almost any number of ways, so don’t be afraid to experiment with them!

Viewing Tables

An entire sub menu dedicated to tables can be found under the View menu, Table XE "View Commands:Tables"  option.
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You can use the tables available in the sub menu to change what information is shown on the task entry table area. 
For example, if we choose the Schedule option, here’s what we would see:
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Here, we can see the start, finish, and slack time for each task. Also note that the Gantt chart is still visible on the left, and we can even split the window to display a different view if we wish.

Sorting Information

Another useful tool is the Sort XE "Sort Command"  sub-menu under the Project menu.
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If you click on an option in the Sort submenu, the current table will be sorted on the field corresponding to the option you click. Here’s an example of our task entry table before the sort:
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If you choose the By Finish Date sort option, the list of tasks will be sorted based on the task finish date.
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You should notice that the task numbers haven’t changed, but their order in the list has.
Using Filters

The next tool available under the Project menu is the Filtered XE "Filters:Default filters"  For feature.
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Filtering a list is quite a bit different from sorting it. When a list is filtered, only those tasks that meet the filtering criteria are shown.

For example, here’s what the same task list as shown above will look like if we filter it by Summary Tasks:
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Both the Task Entry list and the Gantt chart show only our summary tasks. To return to the All Tasks view, just click the Project menu, choose Filter, and click All Tasks. (You can also click the Undo button.)

Using AutoFilter XE "Filters:AutoFilter" 
One of the most useful filtering features Project 2007 provides is the AutoFilter XE "Filters:AutoFilter"  feature. You can turn this option on from the Filtered For menu or by clicking the AutoFilter XE "Filters:AutoFilter"  button ([image: image72.png]


) on the formatting toolbar.

Once you choose this option, AutoFilter XE "Filters:AutoFilter"  arrows will appear at the top of your table columns.
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Now you will be able to click on any of the column header filter arrows and filter your information accordingly.
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Once filtered, column header labels will appear in blue. 
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This indicates that a filter has been applied to this field. 

You can also apply a filter to more than one field at the same time.
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When you do this, only tasks that meet all of the specified filtering criteria will be shown. (For example, a possible filter combination might be all tasks that have duration greater than 1 week and that start on 1/1/07/.)
Section 1: Review Questions


1. Which of the following statements is not true?
A. You cannot add folders to the My Places toolbar XE "My Places Toolbar" 
B. You can create new folders within the Open dialogue
C. You can change how files are displayed in the Open and Save As dialogue
D. Ctrl + O is a valid keyboard shortcut
2. The shortcut key for the Save As dialogue is…
A. Ctrl + S
B. Ctrl + O
C. F12
D. F1
3. The AutoSave XE "AutoSave"  options are made available by… 
A. Clicking on the My Places toolbar XE "My Places Toolbar" 
B. Right clicking on the Project 2007 icon
C. Viewing the file properties
D. Clicking Tools - Options - Save tab within Project

4. Which one of the following statements is true about AutoFilter XE "Filters:AutoFilter" ?

A. AutoFilter XE "Filters:AutoFilter"  adds arrows to your column headings

B. AutoFilter XE "Filters:AutoFilter"  automatically shows only critical tasks

C. AutoFilter XE "Filters:AutoFilter"  is available under the View menu

D. AutoFilter XE "Filters:AutoFilter"  is a new feature in Project 2007

5. The information in the File Properties tells you…
A. When the file was last modified
B. When the file was last accessed
C. What the name of the file is
D. All of the above
6. To view the file properties from within Project you should….
A. Click the Properties button 
B. Choose the Properties option from the View menu
C. Choose the Properties option from the File menu
D. None of the above
7. Which of the following statements best describes a template in Project 2007 
A. A template is a fully completed project.
B. A template only contains a resource list.
C. A template is a project file that contains a project layout and/or information that you may want to reuse. 
D. A template is a type of project report.
8. To arrange windows in project you should…
A. Choose Window followed by Unhide
B. Choose View followed by Split Windows
C. Choose Window followed by Arrange All
D. Click the Arrange All Windows button
9. When you split a window you can...
A. See different views at the same time
B. Save two versions of your project
C. Open two instances of Project 2007
D. All of the above
10. Which one of the following statements is true?
A. Sorting arranges data in order
B. Filtering is the same as sorting
C. Sorting only displays data that meet a criteria that you specify
D. You cannot sort filtered data
Section 2: Using Resources

In this section you will learn how to:

· Create a resource list
· Create a work resource
· Create a material resource
· Use the Resource Information dialogue XE "Resources:Resource Information dialogue" 
· Modify a resource calendar
· Group resources
· Remove resources
· Assign resources to tasks
· Use the Task Information dialogue XE "Tasks:Task Information dialogue"  to assign a Resource

· Use the Task Usage view

· Remove or replace a resource
· Use the Resource Sheet view
· Use the Resource Graph view
· Use the Resource Usage view
· Determine when conflicts occur
· Use the Resource Management Toolbar

· Reassign resources
· Schedule overtime XE "Resources:And overtime" 
· Use Resource Leveling 

Lesson 2.1: Resource Basics

In Microsoft Project 2007, a resource XE "Resources:What are?"  is a person or thing (such as equipment or material) that will be used to accomplish a task. Project 2007 can help you make sure that your tasks are aligned with your resources, to make sure everything gets done on time. It can also keep track of a resource’s cost, to make sure your project comes in according to budget.

You may remember the following basic formula XE "Project Equation"  from the foundation manual: 
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When we talk about units in Project, we are really talking about resources. If a particular type of resource (like a person) is signed to a task, and you add more resource units (more people) to the task, the duration of the task can be shortened (provided that it is not set up as a fixed duration task). 
You can easily rearrange the basic formula shown above into the form that follows: 
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It is easy to see that for a task that requires a fixed amount of work, increasing the resource units will shorten the duration. (Dividing work by a larger number of units gives a smaller result for the duration.) Similarly, decreasing the resource units available will increase the task duration as the amount of total work will be divided by a smaller number.
This concept of effort driven scheduling XE "Effort Driven Scheduling"  is key to how Project works with resources and tasks. Pretty much all of Project’s scheduling features revolve around this basic principle in some way. Since this is such an important concept when it comes to assigning resources to a task, let’s look at it in more detail.

The Work Units Duration Equation

As mentioned above, you can view the relationship between tasks and resources in Project according to the following equation:  XE "Project Equation" 

[image: image79]
The first term in the equation (Task Duration) is the length of time that it should take to complete the given task.

The second term, Total Work, is the total amount of work hours required to complete the task. For example, if our standard (default schedule) of 40 hours per week is used, and a task has duration of three weeks, we have 3 X 40 = 120 hours of total work to complete the task.
The third term, Resource Units, is probably the hardest to understand. There are actually two different ways of specifying Resource units: maximum units and assignment units.

When you first set up a resource, you specify an amount for the maximum units  XE "Resources:And max units"  as a percentage. If a resource will only be able to dedicate half of its working time to a project, you would specify a maximum units value of 50%. If the resource can dedicate all of its working time to the project, you can set the maximum units value at 100%. (Of course, you can specify whatever percentage that best represents the resource’s availability to the project.)

If a resource’s maximum units are 100%, and the resource works 8 hours a day, than every working hour of the day for that resource can contribute to the completion of a task. If the maximum units for the same resource is set at 50%, only 4 hours (half of every day) will be available for work on any given task.

When you assign a resource XE "Resources:And assignment units"  to a task, you specify how much of the resource’s time will be spent on the task by setting assignment units. Just like maximum units, these units are entered as a percentage. 

For example, if you assign 25% of a resource’s time to a task and that same resource is available 8 hours a day for the project, 2 hours a day will be assigned to the task (25% of 8 hours). If you assign 100% resource units to the task, and the resource is available 8 hours a day for the project, the full 8 hours per day will be dedicated to the task in question.

In the context of our equation, if we specify that the task has fixed work, only the duration and resource units can change. (Task Duration = Work / Resource Units) Clearly, if the value for work is fixed, changing one of the other remaining values requires an adjustment in the last value to balance the equation.
For instance if we have 6= 12/2, where 6 represents duration, 12 represents work, and 2 is resource units; changing the units to 4 (and fixing work at 12) implies that the value of 6 (duration) must be reduced for the equation to remains equivalent on both sides (e.g. 3=12/4).
If we have a task that is set up as fixed duration and we change the assigned units, the amount of total work for the task must change to balance the equation.

These are the types of operations that Project performs when you assign resources to tasks. The scheduling of the tasks (and ultimately of your project) will depend on the calendars used, the task type (such as fixed work or fixed duration), the amount of assigned resource units, and the amount of resources available to be assigned.

As a final note, consider what happens if you assign 20% units of a resource to one task and 90 percent units of the same resource to a different task. If the maximum units value for the resource is set at 100% and the two tasks are being worked on at the same time, you will have a problem as 110% (20% + 90% = 110%) is greater than the maximum units available for the resource (100%). When this happens, the resource is said to be over allocated. 
Whenever the task assignment units for a resource exceed the maximum units for the resource, Project will identify the resource as being over allocated. We will discuss overallocation in more detail later on in this section.
Creating a Resource List
The first step in using resources in Project 2007 is to create a resource list. To do this, click the View menu and switch to the Resource Sheet view.  XE "Resources:Sheet view" 
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The Resource Sheet view that appears is much like the Task Entry view: it looks like a table. 
To center a resource, just type the resource’s name in the Resource Name list.  XE "Resources:Creating resource list" 
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Here’s an overview of what each field in the resource sheet is for.  XE "Resources:Sheet overview" 
	Field Name
	Description

	Type
	Tell Project whether this is a work resource (a resource that contributes to the project via hours) or a material resource (a resource that is used up as the project proceeds) or a cost resource. 
Cost resources are new to Project 2007. These cost resources allow you to take into account costs that may be associated with a task, but that are not related to any work assigned to the task.
In Project 2007, you can have multiple non-work related cost resources assigned to a task. If you have more than one type of cost resource in your resource list, you can assign these different costs repeatedly to different tasks and track these costs across all tasks.

	Material Label
	This field is only available for material resources. Use it to define the unit of measure (for example, quarts) for the resource. 

	Group
	Add a keyword to the resource to show affiliation to a particular group (i.e. gardeners, carpenters, mechanics, contract workers, in house workers). 

	Max Units
	Tell Project how much of the resource (what percentage of each day) will be available to work on your project. (We’ll cover this field in detail in the next lesson.)

	Std. Rate
	Tell Project how much this resource costs per standard hour (for work resources) or per unit (for material resources).

	Ovt. Rate
	Only applies to work resources; indicates what this resource’s overtime XE "Resources:And overtime"  rate is.

	Cost/Use
	Designed for material resources; indicates the cost that will be charged once 100% of the resource is used.

	Accrue At
	Determine when standard and overtime XE "Resources:And overtime"  costs are calculated: pro-rated, at the start, or at the end. Only has an effect on interim reports.

	Base Calendar
	Choose which calendar this resource uses. (We’ll talk more about resource calendars in the next lesson.)

	Code
	You can enter any type of information you want here (up to 255 characters), such as an employee’s number or a vehicle’s identification number.


Assigning Work and Material to a Resource
Of all the fields that are available to you, the most crucial are those that allow you to tell Project 2007 how much of the resource can be devoted to the project in question. For work resources, you will certainly want to fill in the maximum work times (Max Units) that the resource can devote to the project.  XE "Resources:Assigning work" 
In this example, the resource (Programmer) can devote 100% of his work time to the project. If you entered 50%, the resource would only be working half time on the project.
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You’ll also want to tell Project what the standard and overtime XE "Resources:And overtime"  rates are for the resource. These hourly rates that you provide will be used by Project to calculate costs. 
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You should always enter a rate for people, even if they’re salaried employees. After all, the company is paying them to work, even if the money doesn’t come directly out of your budget. 
For material resources, you’ll want to enter the material label, and the amount that will be charged per unit of the resource used.  XE "Resources:Assigning material" 
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There are many more resource options that you can set—setting a resource’s working time is particularly important—but we’ll cover those in the next lesson.

Using the Resource Information Dialogue Box
Just like tasks, each resource has its own information dialogue. To view this resource dialogue, double-click on a resource listed in the resource sheet.  XE "Resources:Resource Information dialogue" 
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You can also display this dialogue by choosing the Project menu, followed by the Resource Information option. (You must be in a resource view for this command to be available.)
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The following table provides an overview of each tab in the Resource Information dialogue XE "Resources:Resource Information dialogue" .

	General
	Set the resource’s name, e-mail address, initials, group, code, and type. You can also set the resource’s availability. For example, we could indicate that Bob can give 50% of his time to this project from February 7 to the 14th, and from the 14th on, he can give only 10% of his time.

	Costs
	Vary a resource’s cost using cost rate tables; we’re going to devote a whole lesson to this later on.

	Notes
	A free-form area where you can type in anything you like.

	Custom Fields
	Add custom fields to this resource.


You will also notice a Change Working Time button on the right of the dialogue. 
You can use this button to display a dialogue that will allow you to set up and modify a base calendar for the resource.  XE "Resources:Changing working time" 
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Using the Project Guide Task Pane for Resources

When you first display the Resource sheet view (View - Resource Sheet), you will notice that a Resources Project Guide pane appears on the left of the screen.  XE "Resources:Project Guide for " 
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This pane contains a series of options for dealing with resources. To add resources to your project, click the “Specify people and equipment for the project” link.

When you do this, the following Project Guide pane will appear.
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In this pane, you can specify how you want to add resources to your project. If your company uses Project server, you can get resources from those available on the server. (Note: You must use Project Professional to work with Project Server.)

You can also add resources from a company address book, or directory. For the purposes of this discussion, we will explore the final option, “Entering resources manually.” If you click this link, you will see the following Project Guide and Resource sheet view:
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The Project Guide pane contains instructions for entering the names of people into the resource sheet on the right. There are also hyperlinks to instructions for entering material or cost resources if this is the type of resource you want to add.

Lesson 2.2: Editing Resources

Now that you know a basic procedure for entering resources, it is time to learn more advanced resource modification techniques, including changing the resource calendar, adjusting working time, grouping resources, removing a resource, and replacing a resource.

Changing a Resource Calendar
When you have multiple employees (resources) working on a given project, it is quite possible (even probable) that you will have different employees working different hours.  XE "Resources:Creating a calendar" 
For this reason, you may find it necessary to adjust a resource’s calendar. To do so, just click the Calendar field (from the sheet view) and choose one of the pre-set calendars that are available.  XE "Resources:Choosing a calendar" 
[image: image91.png]1

Type
Work

Material Label

Intials:
0

Group

Meax. Units | Std.Rate | Ovt.Rate | Costlse Accrue At Base Calendar

100%  §3500M 3000 000 Prorated | Standard

24 Hours
hight shift

Overtime.
programmers
tandard

=)

Code





Notice that you can choose from any of the standard base calendars or from any custom calendars that you have created.

Editing Working Time
When a particular resource requires very unusual or unique working hours, you may find it necessary to edit the working time for the resource. To edit a resource’s working time, first double-click the resource to open the Resource Information dialogue XE "Resources:Resource Information dialogue"  box. Then, click the Change Working Time button.
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This action will display the Change Working Time dialogue.  XE "Resources:Changing working time" 
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This dialogue is exactly like the regular Working Time dialogue discussed in the Foundation lessons. You can set working and nonworking hours, using any available calendar as a base. Once you are finished editing the particular details of the calendar as required, click the OK button. The modified calendar will be applied to this resource only.
You can also specify working times for resources by clicking the appropriate link in the Resources Project Guide pane.
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This pane will be available when you switch to the Resource sheet view or if you click the Resources button on the Project guide toolbar.
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When you click the “Define working times” hyperlink in the resources pane, you will initiate a five step wizard for defining and modifying resource calendars.  XE "Resources:Project Guide for " 
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As usual, you choose your options and proceed by clicking the links at the bottom of the pane.
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Grouping Resources
The Group field in the Resource sheet view can come in handy for organizing your resources into groups. To do this, just type the name of an appropriate group for the resource in the group field.  XE "Resources:Grouping" 
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After you have done this, click the Project menu, choose Group, and choose Resource Group. (You can, of course, choose any other setting to view resources grouped according to that criteria.)
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As a result of this action, your resources will be organized by their resource groups.
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Like summary tasks, you can use the plus and minus signs next to each resource group to hide or show the particular members of the group. To un-group resources, just click the Project menu, choose Group, and click the No Group option. Alternatively, you can click the Undo button to return to the state before you performed the grouping action (provided the grouping action was your last previous action).  XE "Resources:Grouping" 
Removing a Resource
Deleting a resource is just like deleting a task. First, click the number of the resource to select it.  XE "Resources:Deleting" 
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Next, press the Delete key on your keyboard, or click the Edit menu and click Delete Resource to remove the selection.
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You should notice that you can also cut, copy, and paste, resources with this menu. (The copy cut, and paste options are also available in the pop up menu when you right click on a resource.) In addition, you can insert resources and drag and drop them into position just as you can with tasks. 

Lesson 2.3: Resources and Tasks

You can now see how Project 2007 can help you organize tasks, calendars, and resources. 
However, to take full advantage of the power of Project, you must understand how tasks, resources, and scheduling work together. This relationship between resources and tasks is a driving force in Project. This relationship also ties in with the central idea of the “Resource Units x Duration = Work” equation mentioned previously.

Essentially, resources aren’t really effective until Project understands how they are going to be used. The next step is to use your resources by assigning them to the appropriate tasks.

Assigning a Resource to a Task (Gantt View)
The easiest way to assign a resource to a task XE "Tasks:Assigning resources to"  is by using the Gantt chart view. If you scroll over to the far edge of the Task Entry sheet, you will see a column called Resource Names.  XE "Resources:Assigning" 
If you click a field in this column, you will see a list of possible resources that you can assign. Simply choose the resource from the list that is appropriate for the task in question.
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That’s it! Project 2007 will now assign the resource you specify from the list to complete the given task.

Assigning a Resource to a Task (Task Information Dialogue)
You can also use the Task Information dialogue XE "Tasks:Task Information dialogue"   XE "Tasks:Assigning resources to" to assign resources to a task. In the dialogue, click the Resources tab. Then, click the table fields to enter the specific resource for the task and the assignment units that they will contribute.  XE "Resources:Assigning" 
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As an example, let’s look at the following software development project. 
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Here, the Build Components task has been selected. You will notice the duration of the task is currently 2 months.

If you double click on the task, display the Resources tab in the Task Information dialogue XE "Tasks:Task Information dialogue" , and choose a Programmer resource at 100% assignment units, the dialogue should look like the following.  XE "Tasks:Assigning resources to" 
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To implement this resource information, click the OK button. 

You will notice that the Build Components task now has a Programmers resource associated with it.
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You will also notice that the Build Components task still has duration of 2 months. This is because this task’s duration is scheduled according to the standard project calendar.

Since the Programmer resource is also scheduled according to the standard calendar, one programmer resource working at 100% (40 hours/week based on the standard calendar) will complete the task in 2 months. Now, if you display the Task Information dialogue XE "Tasks:Task Information dialogue"  again, click the Resources tab, and change the assignment units to 200%, you will see a difference in the task duration.
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After you click OK to implement this change in the resource units, look at the task duration in the task list and on the Gantt chart.
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From this image you can see that the duration for the task is now 1 month. This is because the two month duration was based on 40 hrs/week of work (equivalent to a programmer resource at 100%). Changing the resource units to 200% is like adding an additional programmer at 100%. 

Remember our equation: 

[image: image110]
Increasing XE "Resources:Increasing units"  the units to 200% is like having two programmers, so the equation becomes:


[image: image111]
Since the value for the quantity of work required to complete the task has remained the same, the duration will be half as long as it was before, because now work is divided by two units (200%) instead of one. 

This is a simple example of how assigning resources to a task can change the duration of the task. (It may even change the critical path.)
Using Task Usage View to Modify Resources
When you are using the Gantt chart view, your Project screen will display a task list and a Gantt chart.
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As you now know, if you double click on a task, you will display the Task Information dialogue XE "Tasks:Task Information dialogue" , which you can use to assign resources.

If you choose the View menu, followed by the Task Usage XE "View Commands:Task Usage view"  option, the Project screen will display a Task Usage view of your project
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In this view, you can see the resource assigned to a given task XE "Tasks:Task Usage view"  directly beneath the task’s name in the task list. You will also see the work, the start date, duration, and calendar for the given task. 
As before, if you double click a task, the Task Information dialogue XE "Tasks:Task Information dialogue"  will appear, but if you double click a resource (located under the task it is assigned to), you will see the following Assignment Information dialogue XE "Resources:Assignment Information dialogue" .
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Under the General tab, you can change the assignment units of your resource, as well as the work that is required for the task. Remember, Work = Resource Units x Duration, so modifying the resource assignment with one of these fields can alter how your project is scheduled.
Under the Tracking tab, you can access information about the percent of the task that is complete, and the amount of work that remains. Under the Notes tab, you can enter notes about the assignment of this resource to the given task.

Using the Assign Resources Dialogue
In any task view, you can select a task and use the Assign Resources dialogue to assign a resource to the selected task. You do this by selecting a task and then using the Tools - Assign Resources menu command, the Alt + F10 shortcut, or the Assign Resources XE "Resources:Assign Resources dialogue"  button ([image: image115.png]


) on the standard toolbar.

Any of those three commands will open the following dialogue:

[image: image116.png]Assign Resources

Task: Create documentation
Resource [st options

Resources fram PracticeExercisent4.mpp

Programmers
Resource Name. RD[units |Cost
Programmers

Systems Aralyst

Tech Wrter

Hold down Ctr and clck to select multpl resources





In this dialogue, you can select one or more resources from the list, and then click Assign to assign the selected resource (or resources) at its max units. You can also change the value in the Units field to assign a resource at less than its max units. 

If the task in question already has resources assigned to it, the dialogue will show a check mark by the assigned resource name.
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You can tell that the Build Components task has Programmer resources assigned to it because of the check mark. You can remove these resources, or add additional resources or units if you wish.

Removing or Replacing a Resource

To remove a resource from the task, or to replace it with another resource, use the Assign Resources dialogue in the following way.

First, select the resource in question from the list. In this example the selected resource is Programmers, because this is the only resource assigned. 
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Next, click the Remove XE "Resources:Removing assignment"  button. When you click this button, the checkmark will be cleared from the selected resource.

If you want to replace XE "Resources:Replacing"  the resource with another, click the Replace button. You will then be prompted to choose another resource from a new dialogue box.
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Simply select a replacement resource from the list in the Replace Resource dialogue and then click the OK button.
Lesson 2.4: Resource Views

Just like Project 2007’s task views, there are many ways that you can view resources. In this lesson, you will learn about the three basic views and the situations where they are most appropriate. Remember that you can switch views at any time by simply clicking the View menu and choosing the view you want from the list of options.
Resource Sheet View
The Resource XE "Resources:Resource Sheet view"  Sheet view is the view that we first used to enter our resources into our project.
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This view is best used to create and edit the resources and the resource details for the given project. Remember that you can use other view tools (such as grouping and filtering) from the Project menu to alter how the list of resources is displayed. This view XE "View Commands:Resource Sheet view"  is great for organizing and planning you resources in a way that is similar to how you first planned and entered your tasks.

Resource Graph View
After you lay out your resources in Project and assign them to various tasks, you can use this view to see graphically which resources are used to capacity, which resources still have availability, and which resources XE "Resources:Resource Graph view"  are over allocated.
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Like the Gantt chart view, you can format the timescale, or zoom in or out to see a resource’s usage over time. 

The box to the right of the graph indicates which resource is being currently viewed. In the image above, the box contains the word Programmers in red. This red XE "Resources:About resources colored red"  font color indicates that the resource is over allocated (as do the red bars in the graph).

If a resource was not over allocated, its name would appear in a black font.
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To see the other resources in the graph view, use the small scroll bar on the lower left to bring them into view.
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Moving this scroll bar will display the graphs for your other resources. Remember, the red bars indicate over allocated resources.
Resource Usage View
Once resources are assigned to tasks, their work will be calculated. You can view this work in the Resource  XE "View Commands:Resource Usage view"  Usage view XE "Resources:Resource Usage view" .
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This view lists the resources along with the tasks that they are assigned to. 
For example, you can see in the following image that the Programmers resource has the Build Components task listed immediately below it.
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You can see the working days for the task in the right part of the screen (shaded in yellow). You will notice in the image above that the Tech writer resource is displayed with a black font, while the Programmer and Software Tester resources are displayed in bold red fonts. The red font color indicates that a resource has been over allocated. 

If a resource is listed with no value (amount of hours) in its associated work field, it has not been assigned to a task and is still available.
Lesson 2.5: Resource Conflicts


Resource conflicts can crop up when a resource’s assignment units exceed the maximum units that are available for that resource. It should be mentioned that for a single resource, the total amount of units assigned to different tasks can exceed the maximum units without over allocating the resource, just as long as the different tasks are not being worked on at the same time. 

In any case, Project 2007 has features that make it easy to resolve resource conflicts when they occur.
Determining when Resource Conflicts Exist

As mentioned previously, over-extended resources are displayed in red in resource sheet view.  XE "Resources:About resources colored red"  
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Over-allocated resources also appear in red in the Resource Usage view.
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Over allocated resources also appear in red in the resource graph. This graph, moreover, lets you see exactly when the resource is over allocated and by how much.
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Using the Resource Management Toolbar
The Resource Management toolbar XE "Resources:Resource Management toolbar"  can also help you identify and resolve resource conflicts. You can display this toolbar by right clicking on empty toolbar space and choosing the Resource Management option.
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When you perform this action, you will see the following toolbar appear.
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The following table provides an overview of the function of each button.
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	Switch to Resource Allocation view.
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	Switch to Task Entry view.
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	Go to the next over allocated resource.
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	Assign resources (only available when a task is selected.)
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	Create a new resource from your address book or from your server’s Active Directory.
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	Share resources.
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	Update the resource pool.
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	Refresh the resource pool.
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	Open your address book.
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	View resource details.
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	Filter the information by resource used.
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	Get help with leveling XE "Resources:Leveling"  resources.


Reassigning Resources

One way to resolve XE "Resources:Resolving conflicts"  resource conflicts is to reassign resources. This means shifting the resources around to get the work done, but without over allocating other resources.

For the most part, reassigning resources is easy. Just open the Task Information dialogue XE "Tasks:Task Information dialogue" , delete the resource that you don’t want to use, and select a new one. (See Lesson 2.3 for more information.)
For instance, the following Resource sheet shows that the Programmers resource is over allocated (note the red font).
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Let’s display the Assign Resources dialogue XE "Resources:Assign Resources dialogue"  for each task that has programmers listed as a resource. First, display a task view on your screen like the Gantt chart, select a task, click the Tools menu, and click Assign Resources.
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The Programmers resource has 50% units assigned to the Create Documentation task. The Programmers already have 100% (the max) assigned to another task that occurs at the same time, so this resource has been over allocated.
If we select the Programmers resource by clicking it in the dialogue, and then click the Remove button, the checkmark will disappear, indicating that the resource is no longer assigned to this task.
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Now, if we increase the assignment units of the Tech Writer resource or the Systems Analyst resource (depending on which resource has unallocated resource units), we can still complete the task as per its original duration.
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In the image above, the Programmers are no longer listed as a resource, and the Tech writers are now assigned 100% units to the Create Documentation task. Notice how the cost has been reduced from $1100 (first Assign Resources dialogue) to $800 by this reassignment of resources.
Now, because the assigned units for Programmers do not exceed its max units, it is no longer over allocated. (Note how Programmers is now in a regular black font.)
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Scheduling Overtime

Another way to resolve resource over allocations is to schedule overtime XE "Resources:And overtime" . When you schedule overtime XE "Resources:And overtime"  for a resource assigned to a task, the duration of the task can be shortened.

If there is a conflict caused by resources being over assigned to multiple tasks, shortening a task’s duration is one way free up the resources to avoid the conflict.

Let’s look at the following example.
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Here you can see two tasks that overlap in time. Because the tech writer resource has been assigned 100% to both tasks and the tasks are scheduled (in part) over the same time period, a conflict for the tech writer resource exists.
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To apply overtime XE "Resources:And overtime" , first make sure that you are in Gantt chart view. The next step is to click the Window menu XE "Window Menu"  and click Split so that the task form is at the bottom.
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Next, right-click the form and click Resource Work to display the necessary fields.
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Now, select the appropriate task (the one that you want to shorten) from the task list in the top of the split screen, and enter the amount of overtime XE "Resources:And overtime"  work you want to schedule for the over allocated resource. Remember that you can use the same abbreviations (m, h, d, w, or mo) as you would for task duration.
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For our example, the duration of the task in question is one week with 0 hours of overtime XE "Resources:And overtime" . If we add 9 hours of overtime XE "Resources:And overtime"  and click the OK button (which will appear when the value in the overtime XE "Resources:And overtime"  field is modified), the task duration will change to 0.78 weeks.
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Now, because the task duration has been shortened, the tasks do not overlap.
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Now the Tech Writer resource will no longer be in conflict. However, because the overtime XE "Resources:And overtime"  rate is usually higher and we have scheduled additional hours, the costs for the completion of this task will be increased.
Remember that because overtime XE "Resources:And overtime"  can increase costs, you should not build it into your project plan. Use overtime XE "Resources:And overtime"  to shorten a task’s duration only when you have to.

Lesson 2.6: Leveling Resources 


Essentially, resource leveling XE "Resources:Leveling"  is the process of clearing up resource conflicts and over allocations by delaying tasks or splitting tasks until the necessary resources are available to complete them.
Depending to the degree of how it is implemented, leveling XE "Resources:Leveling"  will often increase the duration of a task, and in so doing increase the length of the critical path and the project as a whole.

Opening the Resource Leveling Dialogue
To open the leveling XE "Resources:Leveling"  dialogue, click the Tools menu, followed by the Level Resources option.
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This action will display the Resource Leveling dialogue.
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Leveling Calculations

In the leveling XE "Resources:Leveling calculations"  dialogue, the upper most group of controls is labeled Leveling Calculations. These controls specify how Project 2007 will level resources.
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If you select the Automatic radio button, tasks will be automatically adjusted (delayed or rescheduled) whenever a resource conflict arises. If you select the Manual option (which is the default choice), leveling XE "Resources:Manual Leveling "  will only occur when you click the Level Now button at the bottom of the dialogue.

If you decide to use automatic leveling XE "Resources:Automatic Leveling" , it is suggested that you clear the “Clear leveling XE "Resources:Leveling"  values before leveling XE "Resources:Leveling" ” checkbox. If you clear this box, Project will only level new and unleveled resource assignments. 

If the “Clear leveling XE "Resources:Leveling"  values before leveling XE "Resources:Leveling" ” box is checked, all previous leveling XE "Resources:Leveling"  values will be cleared and re-leveled, which may take considerable time depending on the amount of conflicts and over allocations that your project contains. 
The drop list labeled “Look for overallocations on a (list item) basis” will adjust the time basis of the leveling XE "Resources:Leveling"  process. For example, if you choose Month to Month from the list items, leveling XE "Resources:Leveling"  will only come into play when over allocations occur within a month. If you choose Hour to Hour, overallocations within one hour will be recognized. (The default setting is Day to Day.)
Leveling Range

You can use the Leveling Range group of controls to establish the specific time period over which your project will be leveled.
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By selecting the Level radio button, you will activate the From and To drop list fields, allowing you to specify a time range for leveling XE "Resources:Leveling range"  to occur within your project. Only tasks/overallocations that fall in the specified time range will be leveled. By default, the “Level entire project” option is selected, which will level the project from its start date to its end date.

Resolving Over Allocations

This final set of controls lets you set up parameters to guide the leveling XE "Resources:Leveling order"  process.
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The leveling XE "Resources:Leveling"  order drop list allows you to specify the order in which tasks are leveled. The default order is Standard, which takes into account task predecessors and dependencies, priorities and constraints, and slack time. If you choose “Priority, Standard” the leveling XE "Resources:Leveling"  order will be based on task priorities first, and the rest of the standard criteria second. If you choose “ID only” tasks will be leveled based on the order of their ID number above any other criteria.
By default you will see the “Leveling can create splits in remaining work” checkbox selected. This means that Project will be allowed to split tasks to help resolve over allocation conflicts. If you want to prevent tasks from being split, clear this checkbox.

The “Leveling can adjust individual assignments on a task” checkbox is also selected by default. This means that project can attempt to resolve conflicts by adjusting when a particular resource works on a task independently of other resources. If you clear this checkbox, Project will not be able to adjust a resource’s work independently.
Finally, if you select the “Level only within available slack” option, Project will only level tasks to a degree that is within the slack time available. This means that the leveling XE "Resources:Leveling within slack"  process will not lengthen the overall project time. However, because the leveling XE "Resources:Leveling"  is constrained by slack time, it is likely that some over allocations will remain unaddressed. It will be up to you to manage these over allocations using some other method.

When you have finished making your settings, click OK to implement them. If you are using manual leveling XE "Resources:Leveling" , click the Level Now button to begin the leveling XE "Resources:Leveling"  process. To undo the effects of leveling XE "Resources:Leveling" , click the Clear Leveling button.
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As a final note, you can compare the results of the leveling XE "Resources:Leveling view"  process with your original project scheme by using the Leveling Gantt view.
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This view is available from the More Views dialogue (View - More Views). The leveling XE "View Commands:Leveling Gantt"  Gantt will show the original project Gantt chart in green bars along with the leveled tasks in the traditional blue format.
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As you can see, the green (original task layout) bars and the blue (leveled) bars will be the same, except where the leveling XE "Resources:Leveling"  process has made a change (such as a split or delayed a task).

Section 2: Review Questions


1. In Project 2007, a resource can be…
A. A person, a material, or a task
B. A task, a cost, or a unit
C. Money, time, or effort 
D. A person, a material, or a cost
2. The fundamental equation that Project uses is… 
A. Duration = Time / effort
B. Work = Units / Duration
C. Resource Units = Assignment units + Material Units
D. Duration = Work / Units
3. The Resource Graph view can show you…
A. Resource Conflicts
B. Overallocations
C. Both of the above
D. None of the above
4. A conflict can be indicated by…
A. A red font
B. A conflict alert dialogue
C. An inability to add more tasks to the project
D. An inability to increase the size of the resource list
5.  A resource can become over allocated by…
A. Assigning the resource to many simultaneous tasks.
B. Assigning a resource with more than its maximum units.
C. Changing the position of a task on the timeline.
D. All of the above.
6. You can assign resources from the …
A. Task Information dialogue XE "Tasks:Task Information dialogue" 
B. Assign Resources dialogue
C. Report dialogue
D. A and B
7. When you level resources you are…
A. Making all task durations equal
B. Making all resource assignments equal
C. Trying to resolve resource conflicts
D. Trying to lower costs
8. Leveling works by…
A. Delaying or splitting tasks so the resources assigned to them are not over allocated
B. Removing resources from the project
C. Increasing the Max Units for the resources in question
D. None of the above
9. The Resource Leveling dialogue is available by… 
A. Choosing Tools - Resource Sharing
B. Choosing Project - Resource Leveling
C. Choosing Tools - Resource Leveling 
D. None of the above
10. If you use overtime XE "Resources:And overtime" , you can… 
A. Increase the costs for a task
B. Decrease the duration of a task
C. Shorten your critical path
D. All of the above
Section 3: Working with Tasks

In this section you will learn how to:

· Use the Task Usage view
· Use the Task Entry view
· Use the Task Name form
· Interpret task indicators
· Use task calendars
· Use Change Highlighting XE "Change Highlighting" 
· Use the Task Drivers XE "Tasks:Task Drivers"  pane
· Link tasks
· Link tasks across projects
· Unlink tasks
· Create Lead and Lag time
· Modify calculation options
· Split tasks
· Overlap and delay tasks
·  Assign variable units to a task
· Organize tasks into phases
· Add time to tasks
· Enter Task Completion Percentages
· Update start and finish dates
· Update Task Duration
· Check variances XE "Variances" 
· Check cost variances XE "Variances" 
· Check work variances XE "Variances" 
Lesson 3.1: Viewing Tasks

In this lesson, we’re going to focus on various task views. This will be very important when it comes to concepts later on in the lesson, so with that in mind, let’s get started!

Using the Task Usage View
This view is easily accessible from the View menu (View - Task Usage). The Task Usage view XE "View Commands:Task Usage view"  lets you enter and see actual work, duration, start, and finish dates for your tasks XE "Tasks:Task Usage view" .
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Using the Task Form View
The task form view allows you to see and modify detailed information about your individual tasks.  XE "View Commands:Task Form view"  To see this view, first select a task in your current view, and then choose View followed by More Views. XE "Tasks:Task Form view" 
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This action will display the following dialogue.
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In the More Views dialogue, select the Task Form option from the list and click the Apply button.

The task form for the selected task will now appear on your Project 2007 screen.
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If you right click on the task form, you will see options (shown in the image above) for the particular fields that will be displayed in the task form.
Using the Task Entry View
The Task Entry view is a split view accessible from the More Views dialogue mentioned earlier (View - More Views).  XE "View Commands:Task Entry view" 
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To display this view, select Task Entry from the More Views list and then click the Apply button.  XE "Tasks:Task Entry view" 
At the top left, you can type in a list of your tasks, as well as their duration, start, finish, and other information. At the top right, the Gantt chart shows you a timeline of your tasks. At the bottom, there is the Task Form that allows you to see detailed information about each task.
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If you right click on the task form, you will see a menu of options for displaying various fields. You should notice that the details shown on the form correspond to the task that is selected in the upper pane. 
If you click the Previous or Next button on the task form, you will see the details for the previous or next task respectively. 
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When you use these buttons, the symbol field in the task list in the upper pane will be shaded in black indicating which task you are currently viewing.

Using the Task Name Form
The Task Name Form can be accessed from in the More Views dialogue as well.  XE "Tasks:Task Name Form view" 
[image: image170.png]views:
Resource Farm
Resource Graph
Resource Name Form
Resource Sheet
Resource Lsage
Task Detalk Farm
Task Entry

=K ame Form

Task Usage

Apply.

Cop.

Cancel




When you select this view, your screen will display the Resources assigned to the task and the Predecessors of the task.  XE "View Commands:Task Name Form view" 
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In Project, strictly speaking, a predecessor XE "Tasks:About predecessors"  is a task that ends before another task starts. The predecessor task must be completed before work can begin on the task that it precedes. The task that follows the predecessor is known as the successor.  XE "Tasks:About successors" 
For a task to have predecessors and successors, it must be linked to other tasks as shown here.
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The arrows joining the linked tasks indicate that a task must be completed before the task that the arrow points to can be started (that is, linked tasks cannot overlap in time).

You can navigate through tasks in the Task Name Form by clicking the Previous and Next buttons.
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As before, right clicking on the form will show a menu of field options that you can choose from.

Lesson 3.2: Working with Tasks

Now that you know how to view your tasks and task details in different ways, it is time to start learning how to work with your tasks. In this lesson you will learn about task indicators (symbols), about task calendars, about change highlighting, and how to use the Task Drivers XE "Tasks:Task Drivers"  feature. 
Task Indicators
In the field to the immediate left of each task name, you may see a task indicator symbol.
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These indicators are a kind of flag that tells you when there is an important feature or information detail associated with the given task. The following table provides a brief description of what the various indicators mean.  XE "Tasks:Indicators" 
	[image: image175.png]



	This task has a note attached to it.
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	This task has a hyperlink attached to it.
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	Project has estimated that this task will finish later than its deadline date.

	[image: image178.png]



	This task has an inflexible constraint.
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	This task has a flexible constraint.
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	This task has not been completed in the constraint time frame.
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	Indicates a recurring task.
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	Indicates a completed task.
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	This task is an inserted project.


We haven’t learned about all of these concepts yet, but these task indicators will come in handy when you get into the details of planning and executing your project.

Task Calendars
You have already heard about base calendars and calendars for your resources. What you may not know is that Project allows you to assign a specific calendar to any particular task.

To assign a task calendar, first display the Gantt chart view. Then, double click on the task in question to display the Task Information dialogue.  XE "Tasks:Task Information dialogue" 
In the dialogue, select the Advanced tab and choose a calendar from the available calendars list.  XE "Tasks:Assigning calendars to" 
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When you select a calendar for a task, Project will base the task scheduling on this calendar. Also, when you specify a task calendar, the “Scheduling ignores resource calendar” checkbox will become available.
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If you put a check in this box and click the OK button, Project will override the Resource calendar of any resource you assign to the task and base the scheduling on the task calendar instead.
Using Change Highlighting XE "Change Highlighting" 
Project 2007 provides a brand new feature called Change Highlighting XE "Change Highlighting" . When you activate this feature and make a change (to a task for example), values in your current view that are altered by your action will be highlighted.
Here is an example. First, turn change highlighting on by clicking the View menu followed by the Change Highlighting XE "Change Highlighting"  option. (If Change Highlighting is already turned on, the option will read “Hide Change Highlighting.”)
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When you activate change highlighting, values associated with the most recent change you made will be highlighted in blue.
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Once change highlighting is activated, the results of each successive change that you make will be highlighted.

Let’s take the project that is shown above as an example. If we extend the duration of the Release software task by dragging the end of the Gantt bar, we will see the following changed field highlighted in blue.
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Notice that the fields that were highlighted previously are no longer shaded. This is because Change Highlighting XE "Change Highlighting"  shows you only the changes that result from your most recent action.

You can also use change highlighting to show the changes from the perspective of different views. For example, here are the changes that result from altering the duration of a task in task entry view.
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Now, if you switch to the Variance XE "Variances"  table view, you will notice that the highlighting of changes persists.
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Remember, in Project 2007 you can undo many successive changes to your project with the new multi level undo feature. If change highlighting was activated, you will see the highlighted changes corresponding to each successive action that you took as you undo them one by one. 
Using the Task Drivers XE "Tasks:Task Drivers"  Pane
Sometimes the way Project schedules your tasks can seem quite mysterious. This can be a real problem if your project has hundreds or perhaps thousands of tasks because it becomes so difficult to keep all those links and dependencies and resources sorted out. 
If you are ever confused by the way Project 2007 arranges a particular task, try out the new Task XE "Tasks:Task Drivers"  Drivers feature to see if you can clear things up. This feature is basically a task pane that appears on the left of your Project screen. In the task pane, you will see a list of information detailing the factors or influences that are driving the task in question.
To use the task driver pane, first select the task that you want to look into.
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Next, click the Project menu, followed by the Task Drivers XE "Tasks:Task Drivers"  option.
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The resulting task driver information will appear in a task pane at the left of the screen.
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In this case, you can see that the selected task is influenced by a predecessor task, and by the standard calendar.

In a large project with many dependencies, you could have any number of factors listed in the Task driver pane.

Lesson 3.3: Linking Tasks

As you plan your project, you will find that some tasks depend upon others. For example, you can’t begin building an office tower until the land has been excavated and a foundation is in place. Similarly, you cannot send your custom documentation out for printing until after the documentation has been created. In cases like these, the task that must be finished first is called the predecessor task, and the task that starts afterwards is called the successor task.

Sometimes, a task may be dependent on another task (forming a kind of link), but it may not be a strict predecessor or successor. (For example, it may not have to finish before a successor starts, or after a predecessor finishes.) Or, a task may have to start at the same time as another task (not after it, or finish before it). This task is said to be dependent on the task that it must share a start time with.

In this lesson, we’ll learn how to link and unlink tasks within and across projects. We’ll also learn about lead time and lag time, which will help manage linked tasks.

Link Types

There are four types of task links XE "Tasks:Link types"  in Project.

	Finish to Start (FS)
	When the predecessor task finishes, the successor task will start. This is the default link type in Project 2007.

	Finish to Finish (FF)
	When the task that is depended on (predecessor) finishes, the dependent task (successor) must finish.

	Start to Start (SS)
	When task that is depended on (predecessor) starts, the dependent task (successor) must also start.

	Start to Finish (SF)
	When the task that is depended on starts, the dependent task must finish.


Once you link tasks, the link type can be set in the Task Information dialogue XE "Tasks:Task Information dialogue"  for the dependent (successor) task.
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Linking Tasks within a Project
To link tasks, first select them in the task XE "Tasks:Linking within a project"  list. (You can select non adjacent tasks by pressing the Ctrl button as you click on them.)
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After you have selected your tasks, click the Link Tasks button ([image: image196.png]


) on the standard toolbar. (You can also click the Edit menu and click Link Tasks, or use the Ctrl + F2 shortcut.)

No additional information is necessary; the links will be implemented as soon as you perform these actions.
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Now, the project will take on a much more realistic timeline. Note that linked tasks are marked with arrows that point from predecessor to successor. (By default, these will be finish to start links.)
Unlinking Tasks within a Project 
To unlink tasks, first select the task that you want to unlink.  XE "Tasks:Unlinking" 
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Next, click the Unlink Task button ([image: image199.png]


) on the standard toolbar. (You can also click the Edit menu and click Unlink Task, or use the Ctrl + Shift + F2 shortcut.)

When you perform these steps, the selected task will be unlinked.
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Notice that the timeline for the sequence of tasks has been shortened (the bars on the Gantt chart are closer to the left).

You should also notice that the links at both ends of the selected task have been removed. (This means that the task is no longer a predecessor or a successor.) In addition, the task that was the selected task’s predecessor is now linked to the task that used to be its successor. 
When you add or remove task links, consider the results and make sure they are appropriate and realistic for your project.

Linking Tasks Across Projects
If you are managing multiple projects, you may find that the timelines for different projects overlap.  XE "Tasks:Linking across projects" 
 As an example, suppose that you have created and saved a second smaller project, just for planning your meeting with the president. (This might seem like an extreme case of micro management, but it is only for the purposes of explanation.)
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Of course, the meeting with the president should not take place until this small preparation project is completed. Luckily, Project 2007 makes it easy for you to link tasks across different projects.

First, use Project 2007 to open both projects. Next, click the Window menu XE "Window Menu:Arrange All command"  and click Arrange All so you can see both projects at the same time.
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Now, select the task that you want to link to the external project. (In the sample above, you can see that we’ve selected Task #26 Meet with President from the main project.)
Next, open the Task Information dialogue XE "Tasks:Task Information dialogue"  for the selected task. In the ID field, type the name of the other project that you are linking to (MeetingPreparation) followed by a backslash (\) and the task number of the appropriate task in the other project.
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When you are ready to proceed, click the OK button.
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The new link will now be indicated in the task entry areas of both projects by the insertion of the respective task names. It will also be indicated in the Gantt charts as a light grey bar with link arrows. If the information in the predecessor task (in the external project) is updated, the main (linked) project will update, too.

Unlinking Cross-Project Tasks
Unlinking tasks across projects is easy. Just select the successor task and then execute an Unlink command (the Unlink Task button, Edit - Unlink Task, or the Ctrl + Shift + F2 shortcut).  XE "Tasks:Unlinking" 
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When you do this, the inter-project dependencies will be removed.
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Using Lag Time and Lead Time

When tasks are linked from finish to start, you may wish to overlap the predecessor task or delay the successor task. For example, you may want to provide some extra slack time between dependent tasks in case it becomes necessary to shorten the critical path, to level resources, or to adjust for other errors in planning. (After all, you may not have all of the information required when you are first planning your project.)

You may also wish to start a dependent task early; perhaps there is some part of the dependent task that can be accomplished before the predecessor is complete. When you start a dependent task early, you are overlapping it with its predecessor.

The examples mentioned above can be realized with the introduction of lag time into your linked tasks.
To enter lag time XE "Tasks:Lag time"  (a delay between the linked tasks), first you must select the successor task (the one that is second or dependent), and then open Predecessor tab of the Task information dialogue.
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Enter the lag time you need in the field provided using the standard duration abbreviations (m, h, d, w, mo, or y). 

Once you click OK, you’ll see a (lag time) gap between the two linked tasks in the Gantt chart.
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To enter lead time XE "Tasks:Lead time"  (overlap) use the same process, but this time enter a negative value in the Lag field.
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As a result, the dependent task will overlap its predecessor by the amount of lag time that you specified.
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Lesson 3.4: Editing Tasks

In this lesson, we will delve further into the subject of modifying and manipulating task properties. You will learn about calculation options, splitting tasks, overlapping tasks, delaying tasks, and assigning variable units to a task.
Updating Calculation Options
You will recall the fundamental equation that drives Project’s XE "Project Equation"  scheduling mechanisms.

[image: image211]
This equation has three terms: Duration, Work, and Units. For any task in project, you can decide which term in this equation will be adjusted when you add or remove resources to and from a task. The way to control which term is adjusted is to set a particular task type for the task in question.

To do this, double click on a task to display the Task Information dialogue XE "Tasks:Task Information dialogue" . In the dialogue, click the Advanced tab to display the task configuration options.
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In the task type drop list, you will see three options: Fixed duration, Fixed Units, and Fixed Work. The way that Project calculates the scheduling of tasks depends on the fundamental equation shown above and on what task type XE "Tasks:Types of"  you have set.

· If the task type is set to fixed work, Project will shorten the duration of the task when resources are added (increased).
· If the task type is set to fixed units, Project will shorten the Duration of the task when resources are added.

· If the task type is set to fixed duration, adding more resources will decrease the amount of individual units for the resources assigned to the task.

You will notice that in all of these cases, the total work for the task is held constant, while the other terms of the equation are adjusted. This is because by default, all tasks in Project are effort driven (meaning the total work does not change).

If you want to model a situation where the total work for the task can change as you add or remove resources; you must clear the Effort Driven XE "Effort Driven Scheduling"  check box in the Task Information dialogue XE "Tasks:Task Information dialogue" .
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(If the task type is set to Fixed Work, you will not be able to access the Effort Driven check box.)

The way that Project calculates total work and scheduling for a task is very important. If you can really understand this concept, you will make great strides towards mastering the Project application. With this in mind, let’s look at this in a little more detail.

As an example, we will assign a resource (for the first time) to an effort driven XE "Tasks:Effort driven"  task.
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In the example image above, the screen has been split (Window - Split) to provide a better illustration of what is happening. 
The very first resource assignment to the selected task is a Tech Writer resource at 100% units. When we click OK in the Task information dialogue, Project will calculate the work time for the task based on the duration, and the amount of resource units assigned. 
Because the tech writer resource has been assigned at 100%, Project will establish the total work for the task to be 80 hours. That means, two weeks at the 100% units level for a tech writer (as they work 40 hours/week).
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Now Project has established the total work for the task at 80 hours, based on the first resource assignment and a duration set at two weeks. Subsequent resource assignments for this effort driven task will change the duration according to this equation: duration = work/units.

Next, suppose we now add some additional resources to this task.
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Here, we add a Systems Analyst resource to the task at 25% assigned units. Now, the duration will be changed because there are two resources working on the same effort driven task.
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Here are the results of the added resource. We see that the total work is still 80 hours (64 + 16) and that the duration has been decreased to 1.6 weeks. (The task will be completed sooner because of the additional resource.)
With a task that is not effort driven, additional resource assignments will not change the duration of the task. Instead, the hours of work will be calculated for each assigned resource based on the equation Duration = Work / Units. That is to say, for a non-effort driven task, the total work required to complete the task will change.
As an example, consider the same task and assignments as before, but this time the Effort Driven check box is cleared before any resources are assigned.
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The tech writer resource has been added at 100% units as a first resource assignment. The duration has already been set to two weeks, and total work is calculated to be 80 hours.

The following image shows the results of adding a Systems Analyst resource, at 25 % assigned units.
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You will now notice that the total work for the task has increased to 100 hours (80 + 20). This is because the task is not effort driven. The Duration = Work / Units equation is calculated individually for each assigned resource, and the calculated work for each resource is displayed in the Work column. 

You should also notice that the duration of the task (two weeks) has not changed at all with the addition of the new resource.
Go over this concept until you are sure you understand it. Experiment with assigning resources to tasks, especially with what happens when you make a first resource assignment (which establishes total work) versus subsequent resource assignments. Also experiment with changing the task type and with clearing the effort driven check box. 

When you modify a task’s resources), Project 2007 may display an action button XE "Resources:Action button"  next to the task in question.
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You can influence how Project deals with the task modification by selecting the radio button that reflects the result that you want. 
Splitting a Task
In a nutshell, splitting a task XE "Tasks:Splitting"  means breaking a task into two or more pieces so that a part or parts of the task start at later dates. This can be helpful if you find that a task or particular component of a task will be delayed for some reason.

To split a task, first locate the task in the Gantt chart.
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Next, click the Split Task button ([image: image222.png]


) on the standard toolbar and then place your mouse pointer on the task in the Gantt chart. Click and drag with your mouse to insert the split.
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Once the split is inserted, task time will be extended and the split time will be marked with a series of dots.
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To remove the split, click the Split button again, and use your mouse to drag the far piece back toward the earlier part of the task. You could also simply click the Undo button if the split was the last action you performed.

Overlapping Tasks
If it seems like your project will take too long to complete, or if you want to fast track it for some other reason, it is possible to shorten the length of your project by overlapping XE "Tasks:Overlapping"  tasks. 

As an example, suppose that your project consists of making a movie. Although it might be ideal to have the screen play and script entirely completed before filming begins, it is possible to start filming the parts of the story that are finalized even though the entire storyline is finished. (For example, you could certainly film an introductory scene before the final scene has been written.)
To accomplish this in Project, you would overlap the tasks. The filming of the movie cannot finish before the writing of the movie is complete, but some parts could be filmed while the movie is still being written.

On a Gantt chart, overlapping tasks look like this.
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In this example, the writing of the movie is roughly half complete when filming begins.

There are a number of ways to overlap tasks in Project. First, you can just use your mouse to drag the task’s Gantt bar into an overlapping position.
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When you release your mouse button after dragging, you may see a dialogue like the following:
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If you dragged the task in question close to the end of the task that it will overlap, Project may assume that you are trying to link the tasks (see Lesson 3.3). If you do not want to link the tasks, select the “Move <task name> without adding a link” radio button and click OK.

As well, when you reposition a task on the timeline by dragging it, Project will automatically apply a Start No Earlier Than constraint corresponding to the date where you position the beginning of the task.
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In this image, you can see the constraint that has been applied after the task is repositioned. You could also overlap the task by displaying the Task Information dialogue XE "Tasks:Task Information dialogue"  and entering the same constraint manually. 

You will remember from Lesson 3.3 that if you add negative lag time to a linked task, you will create an overlap.

Here we have two tasks with a finish to start link. 
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In the following dialogue, we display the Predecessor tab of the Task Information dialogue XE "Tasks:Task Information dialogue"  for the successor task, and then enter a lag of -3 days. The tasks will overlap by this amount of time.
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Now, clicking the OK button in the dialogue will produce the following result.
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As you can see, the tasks are still linked, but they overlap as well.

When you want to overlap tasks you should consider some of the potential risks. First, if the tasks you are overlapping make use of the same resources, a conflict can easily occur.

Also, there is always a chance that the task that starts first will have to be revised or reworked, in which case a dependent overlapping task may also need revision. (If the beginning of a movie is re-written after it has been filmed, the scene will of course have to be re-filmed as well.) This kind of backtracking wastes both time and resources.
Delaying Tasks
There are a number of ways to delay XE "Tasks:Delaying"  tasks in Project. In a trivial way, you can simply push back the start date of the task by dragging the Gantt bar for the task, or by entering a new start date directly.

As you already know, decreasing the amount of resource units assigned to a task can increase its duration (Duration= Work /Units). This can certainly push back or delay the completion of a task.

There is always the possibility that a resource assigned to a task may be suddenly required for another task that has a higher priority. In this case, you can split the task by using the split button ( [image: image232.png]


). (Please see the previous concept.) 
When you split a task in this way, the length of the delay will be shown by a dotted line.
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Work on the parts of the task that occur after the split will be resumed after the indicated delay period. During this delay, the resources used in the task will be available for use elsewhere (on a higher priority task) without creating a conflict.

Assigning Variable Units to a Task

Project 2007 lets you adjust how a resource is available over the duration of your project. For example, it may be the case that a resource is available for more or less work at different points in the project life cycle. One way to give your resources varying availability over time is to assign variable units to your resource.

To do this, first display the resource sheet by choosing the View menu, followed by the Resource Sheet option.
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In the Resource Sheet view, double click on the resource that you want to adjust to display the Resource Information dialogue XE "Resources:Resource Information dialogue" . Under the General tab, you will see a Resource Availability XE "Resources:Resource Availability table"  table. Enter the time that the given resource is first available in the available from field. You can click on the field to select dates from a pop up calendar.
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Next, enter the date that the resource will stop being available (at a specified units level) in the available to field. 

Finally, enter the level of units that are available for the resource in the Units field of the table.  XE "Resources: Variable units" Simply repeat this process to create several varying durations of different resource availability.
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When you have finished entering the varying units for the resource, click the OK button to implement the setup.
Another topic that is closely related to varying resource units is work contouring. Project allows you to choose from eight preset work contours XE "Resources:Work contours" . You can apply these contours to a resource assignment to distribute or skew the work being performed over the timeline of the resource assignment.

If you apply a front loaded work contour, most of the assigned work will occur near the beginning of the task duration. Similarly, if you apply a back loaded work contour, most of the work will happen at the end of the assignment (task) duration.
To apply a contour, select the Task Usage view from the View menu. When this view appears, double click the assigned resource (visible beneath the resource’s corresponding task). This will display the following dialogue.
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In the work contour drop list, you can select one of the eight preset work contours XE "Resources:Work contours" .

The following table provides a brief description of the contour presets.

	Flat
	This is the default contour. Work is spread out evenly over the task duration.
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	Back Loaded
	Work peaks at the end of the task duration, meaning most of the task will be completed near the end.
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	Front Loaded
	Work peaks at the beginning of the task duration, meaning most of the task will be completed near the beginning.
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	Double Peak
	Work peaks twice during the task.
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	Early Peak
	Work peaks early in the task.
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	Late Peak
	Work peaks late in the task.
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	Bell
	Work ramps up, goes to full-time, and then ramps down.
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	Turtle
	Work ramps down slightly at the beginning and end of the task.
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When a contour has been applied to a resource assignment, you will see its symbol in the indicator column:
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Here’s an overview of each contour type and their indicator.

	Flat
	No indicator as this is the default type.

	Back Loaded
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	Front Loaded
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	Double Peak
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	Early Peak
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	Late Peak
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	Bell
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	Turtle
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Here is an example of the use of a work contour. Suppose that we have two tasks that overlap as shown below.
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Both of these tasks (that overlap as shown by the red square) use the Systems Analyst resource. The higher (later) task uses 23% units, while the lower task uses 100% units. Because the tasks overlap, there is a resource conflict (100% + 23%=$123%, more than the 100% max units).
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The task that appears lower in the Gantt chart is called Create Documentation. This task also starts earlier than the task that it overlaps. To assign a work contour to the Create Documentation task, choose View followed by Task Usage.
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In the task usage view, we look for the task that we want to contour (Create documentation) and double click the assigned resource shown beneath it.
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In the Assignment Information dialogue XE "Resources:Assignment Information dialogue"  that appears, we can apply a front loaded work contour. This means that most of the work in this resource assignment will be done at the beginning of the task duration. Hopefully, this will free up resource availability at the end of the task duration (the part of the task that overlaps with the other task). To apply the contour, select the contour type from the list and click the OK button.
Now if we look at the resource sheet, we find that there is no longer a conflict.
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This is because the front loaded task (with 100% assigned units) gets most of the work done at the beginning of the task. The later, overlapped task (with 23% assignment units) does not begin until most of the work has been done on the contoured task. Because of this, there is enough of the resource available to avoid a conflict.

Of course, applying contours could just as easily create a conflict depending on how the assigned work is skewed. When you want to use contours, look over your Gantt charts and resource assignments carefully.

Organizing Tasks into Phases

If your project is quite large, involving numerous (perhaps hundreds of) tasks, it may be a big help to organize your tasks into phases. A phase can be defined as a grouping of tasks that are logically or temporally (meaning having a similar time frame) related in some way.

For example, when making a movie, you might group pre-production tasks and post-production tasks into to distinct phases. A middle phase might be the actual filming of the movie. 

The completion of a phase can be seen as a milestone in the life cycle of your project, with each individual phase being a kind of mini project on its own.
Essentially, you can create phases XE "Tasks:And phases"  in a project by creating summary and sub tasks (foundation manual) with the indent/out-dent buttons.
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Look at the following list of tasks as an example.
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Tasks one to six can be grouped as pre-production tasks. That is, all of these tasks should be in place, or at least underway, before actual filming begins.

Tasks seven to 14 might be grouped in a production phase, and tasks 15 to 19 can be grouped into a post production phase. 
If you create new summary tasks called Pre Production, Production, and Post Production, assign the appropriate subtasks to these phases with the indent button, and create a milestone at the end of each phase, your film project might look like this.
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Now the film project is grouped into three distinct phases. You can see the milestones signifying the completion of the phases in the Gantt chart. Even though no start times or durations have been applied to the tasks, you can see already how this phased approach can help you organize your project and break it down into more manageable parts.
Lesson 3.5: Completing Tasks


Once your project is planned out, it’s time to start executing it. In this lesson, you’re going to learn how to update work that you have completed so far on a project.

Entering Task Completion

To change a task’s completion XE "Tasks:Entering completion percentage"  percentage, first double-click the task to open the Task Information dialogue XE "Tasks:Task Information dialogue" . (For summary tasks, you must use the Task Information button on the standard toolbar.) Next, on the General tab, enter the percent complete.

[image: image262.png]Task Information

General Predecessors

Neme: [Buld Companers

Percent completer] |40% 5|

Dates
storts [P 111/08

[Chide task bar
[JRollup Gantt bar to summary

Resources

Advanced

] Erish;

Thu 3/6/08

Notes,

Durstion

Priarity:

S

ETE

| cuson rs

Oestimated





Once you are ready, click the OK button.
Tasks that are 100% complete will have a check next to them, like this:
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Updating Start and Finish Dates

In a real project, it is possible that a task will take longer or shorter than you originally planned for. If this happens, Project has a mechanism to allow you to update the actual percent complete, start, and finish dates, without changing your original task duration, in case you want to keep your original duration estimates.
To make these updates XE "Tasks:Updating start and finish dates" , you should first change to the Task Usage view. You can do this by clicking the View menu and then clicking Task Usage. Next, double-click the resource under the task that you want to fill in work for.
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This action will open the Assignment Information dialogue XE "Resources:Assignment Information dialogue" . Under the Tracking tab, you can update the actual work, actual start and finish dates, and percent complete XE "Resources:Updating work" .
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When you do this, Project will calculate the percent of work that this resource contributed and calculate the amount of hours that remains to complete the task. In this case, the task is completed with slightly more work than the original estimate (15 hrs instead of 14.72).
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Changing Task Duration

When you first enter your tasks into project, one of the fields available in the Gantt chart view is Duration. The duration for a task can be entered directly into this field, or you can drag the end of the task’s Gantt bar with your mouse to graphically adjust the duration. 

When you reposition a task or increase the duration XE "Tasks:Modifying duration"  by mouse dragging, the start and finish times will be entered automatically. A question mark beside the duration value for a task signifies that the duration is an estimate (as opposed to an actual duration). If you enter duration directly, and you want to make sure that Project knows it is an estimate, enter a question mark immediately following the duration value.

In this image, an estimated duration of one week is being entered.
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If we double click on the task that was just entered (see image above), you will see the following information under the General tab of the Task Information dialogue XE "Tasks:Task Information dialogue" . 
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Notice that the duration is specified as Estimated and the percent complete is 0%. Now, suppose at a later date the task is completed. In the Task Information dialogue XE "Tasks:Task Information dialogue" , we can enter the percent completed (100%) and the actual finish date.
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Notice that the actual finish date (Tue 1/15/08) has taken us well beyond the estimated duration of 1 week. When we click the OK button the new duration will be calculated from the start and finish dates.
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If you prefer, you can enter a new duration directly into the Task Information dialogue XE "Tasks:Task Information dialogue" .

Here, 1.5 weeks has been entered instead of 2 weeks.
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As a result of this, the task finish date will be calculated accordingly based on the start date and the new duration.
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Changing Remaining Work

As your project proceeds and you enter values for the percentage completed, it is not unusual for some tasks to take longer than expected. If you notice that a task is not likely to complete based on the original amount of work assigned, you can easily enter a new amount for work remaining. To do this, first choose the Gantt Chart view, and then click View, followed by Table, followed by Work.
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The resulting screen will look something like this.
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In this view, you can see that the task is 33% complete. You can also see a field for the Remaining Work outstanding on the task (53.6 hours in this case). If you look at the Gantt bar for the task, you can see a thick black line running through the bar as a graphical indication of the percentage of work completed. 
If you think that the task will take longer to complete than originally estimated, you can change the value for the remaining hours. To do this, just enter a new value in the Remaining XE "Tasks:Modifying Remaining Work"  field for the task in question. (In this case, we will replace 53.6 hrs with a new value of 60 hrs and press Enter.)
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Here you can see that the Work field, Percentage Completed field, and the length of the task’s Gantt bar have all been adjusted to allow for the new value in the Work Remaining field. The duration, finish date, and the percent completed for the task have also been changed to accommodate the new remaining hours value. Keep in mind, this kind of update could easily result in resource conflicts.
Lesson 3.6: Working with Variances


As you execute your project, you will probably want to track its progress and see how you’re coming along in terms of budget and time. Project’s variance calculation tools can help you stay on top of things and stay within your project’s limits.

Using the Variance XE "Variances"  Table

To view the variance table, first make sure you’re in Gantt chart view. Then, click the View menu, choose Tables XE "View Commands:Variance table" , and click Variance XE "Variances:Viewing" .

[image: image276.png]Wiew

Colendar
Gontt Chart
Network Disgram
Task Usage
Tracking Gantt
Resource Graph
Resource Shest

Resource Usage

More Views.

Tabe: Enry ot

Toolbars Entry.

View Bar typerink.

S vice Chenge Hhighting schedie

eader and Fotar Summery

Zoom, Trckng
U
work.

More Tables.





Now you can see the actual start and finish dates and the baseline start and finish dates.
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You can also click in any of the Start and Finish columns to change the actual start and finish dates. (You should not change the baseline values.)
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 You can also sort, group, filter, and AutoFilter XE "Filters:AutoFilter"  the variance table.
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Checking for Variances

There are a number of ways to check for variance in Project. Basically, a variance is a difference (discrepancy) between the baseline plan for a project and the actual (current) state of a project. 

Since many types of values can be altered by delays, rescheduling, resource leveling XE "Resources:Leveling" , and other factors, there are many types of variances XE "Variances"  that you can look for. 

Probably the most direct way to check for variances XE "Variances"  is by examining the variance field for the kind of information you are interested in. For example, in the main variance table, you can see start and finish time variance for the tasks in your project.
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In the image above, you can see that the finish variance for the Revise documentation task is negative 4.5 days. A minus sign indicates that the value is below or early compared to the baseline. For this task, the finish date is 4.5 days early. You can also see that the Create documentation task has a start variance of 4 days. This means that this task started 4 days late (as compared to the baseline).
Another way to check for variances XE "Variances"  is to display the Variance XE "Variances:Filtering"  table as shown above, and then choose the Project menu, followed by the Filter For option, followed by More Filters.
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In the More Filters dialogue, choose a filter like Slipping Tasks.
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Once you are ready, click the Apply button to implement the filter.
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As a result, you will see a list of tasks and their variances XE "Variances"  that have slipped (meaning are behind schedule).
If you just want to get an overall, project wide picture of progress and variances XE "Variances" , click the Project menu and click Project Information XE "Project Information Dialogue" . In the resulting dialogue, click the Statistics button:
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Clicking this button will display a dialogue like the following:
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This Project Statistics dialogue displays a concise summary of your project’s current, baseline, actual, and remaining duration, work, and cost. It also shows you completion percentages for duration and work.
Work Variances

Although the variance table can be useful for tracking scheduling, by default it does not show actual and remaining work. You can switch to the work table by clicking the View menu, clicking Table, and then clicking Work XE "Variances:Work" .
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This table will show you the actual and remaining work, as well as the percent of work completed. It also shows the baseline work values and calculates the variance. A positive variance means you’re behind schedule, while a negative variance means you’re ahead of schedule.
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The two tasks shown in the red box are 100% complete and have a positive variance. This indicates that these tasks are behind schedule as they required more work hours than estimated. Like other tables, the Work Variance XE "Variances"  table can be filtered, grouped, and sorted to provide maximum flexibility.

Cost Variances

It can be quite useful at many points in your project life cycle to have a look at how your project costs are going. You can easily view cost variances XE "Variances:Cost"  by clicking View, clicking Table, and then clicking Cost XE "View Commands:Cost Variance table" . The resulting cost view will look something like this: 
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You will see fields for fixed cost, total cost, baseline costs, variance, and actual costs. The central columns in the table are the most important: they show your baseline and actual costs and the variance between them.

[image: image289.png]Baseine | Variance | Actual

5200000 5000 5200000
$0.00 $0.00 $0.00

1120000 $56000 §11,760.00

$0.00  $830.00 $0.00
5000 5000 5000
5000 5000 5000
5000 5000 5000
5000 383000 5000
160000 5000 §1,60000
524000 5000 524000
5000 5000 5000
5000 5000 5000
5000 5000 5000
5000 5000 5000

3000 3000 3000




We can see that the third and fourth tasks are over budget (the actual costs are available and there is a positive variance). We will hope that this is not a trend for the entire project.

Like other tables, the Cost Variance XE "Variances"  table can be filtered, grouped, and sorted to provide maximum flexibility.

Section 3: Review Questions


1. Which of the following statements is true?
A. In Project 2007, you cannot apply a task calendar
B. In Project 2007, scheduling is based solely on the Resource calendars
C. In Project 2007, you can make a task calendar override a resource calendar

D. All of the above
2. Task Drivers XE "Tasks:Task Drivers"  are…
A. A transportation resource
B. A factor influencing the scheduling of a task
C. A type of calendar 
D. None of the above
3. Change Highlighting XE "Change Highlighting"  will highlight… 
A. The changes in your file since the last time you saved it
B. The changes in your project that result from an action you take
C. There is no such thing as Change Highlighting XE "Change Highlighting" 
D. The Task Drivers XE "Tasks:Task Drivers" 
4. To link tasks in Project you can…
A. Select the tasks and then click the Link button
B. Drag the task into position after another task with your mouse and then click OK in the Planning Wizard dialogue
C. Specify a predecessor task in the Task Information dialogue XE "Tasks:Task Information dialogue" 
D. All of the above
5. A finish to start task means that… 
A. The successor task normally completes after the predecessor
B. The predecessor normally completes after the successor
C. The tasks will complete at the same time
D. The tasks will start at the same time
6. Lag time can be described as…
A. The time between the start and end of a task 
B. The duration of the critical path
C. A delay between linked tasks
D. A split
7. Negative lag time will cause the successor task to…
A. Start early
B. Start late
C. Finish late
D. Become unlinked
8. When you split a task you can…
A. Cause resource conflicts
B. Delay the task
C. Increase the duration of your critical path
D. All of the above
9. Which one of the following statements is true?
A. Splitting a task is the same as linking a task
B. You can sometimes resolve a resource conflict by splitting a task
C. You cannot split a linked task
D. Split tasks must be completed before linked tasks
10. In general, a negative cost variance means….
A. The task is coming in under budget
B. The task is over budget
C. The Project is running late 
D. The critical path has been shortened
Section 4: Creating Reports

In this section you will learn how to:

· Use the Reports dialogue box
· Create a pre-defined report
· Create a custom report
· Use the Project Guide to print a report
· Open the Visual Reports dialogue
· Edit a report
· Create a report template
· Select a reporting cube
· Use the Field Picker

· Save a report cube
· Save a report database
· Use the Copy Picture feature
· Use the Copy Picture to Office Wizard XE "Reports:Copy Picture to Office Wizard" 
· Create reports with the Project Guide
Lesson 4.1: Creating Reports

If you are managing a major project, chances are that you’re going to want to develop a report on it at some point. Luckily, Project has some useful tools to easily summarize and organize key parts of your project.

Using the Reports Dialogue Box
In Project 2007 you can open the Reports dialogue box by clicking the Report menu and then clicking the Reports option.
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This action will display the following Reports XE "Reports:Menu"  dialogue.
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From this dialogue, you can simply choose a report type the best meets your needs and click the Select button. 

Creating a Pre-Defined Report
To create a pre-defined report XE "Reports:Creating basic" , just click one of the categories from the Reports dialogue and click Select. Next, you will be asked to choose a report sub-type. For example, if we choose Current Activities from the Reports dialogue, here are the report sub-types we will see:

[image: image292.png]Current Activity Reports

Completed Tasks  Should Have Started Slpping Tasks
Tasks





Once you click a report sub-type, you can click Edit XE "Reports:Editing basic"  to change its fonts or you can click Select to see the report in print preview. Here is the print preview for the Unstarted Tasks report:
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As you can see, it is a fairly simple process to get your information neatly organized and ready to go.

Creating a Custom Report
Although the pre-defined report XE "Reports:Creating custom"  categories are useful, there may be times when you want specific information for your report. 

To create a custom report, open the Reports dialogue box, click Custom, and then click Select.
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This action will reveal a dialogue with a more extensive list of report types.
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You can choose a report from this list and click Preview (to invoke the Print Preview XE "Print Preview"  window), Setup (to invoke the Page Setup dialogue), or Print (to invoke the print dialogue).

 You can also click the Edit button to edit the font that the report will be printed in or, you can click the New button to create a report from scratch.

If you click the New XE "Reports:Creating new"  button, you will see a dialogue like the following.
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Select a report type from this dialogue and click the OK button to display the next dialogue.
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In the Task Report dialogue, you can add and arrange report details with the Details and Sort tab options. If you click the Text button, a dialogue will open with options for changing the font and formatting of the report’s text.

Under the Definition tab, you can enter a name for your report and specify a period according to which the report information will be organized.

When you click the OK button, your new custom report will appear in the Custom Reports dialogue.
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If you click the Organizer XE "Reports:And the Organizer"  button in the Custom Reports dialogue, you will display an Organizer dialogue that you can use to copy, rename, and delete reports from your custom lists.
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Lesson 4.2: Creating Visual Reports

Project 2007 provides a great way to produce eye catching project reports. This new feature, called Visual Reports, allows you to use Microsoft Excel XE "Microsoft Office Project:And Microsoft Office Excel"  or Visio XE "Microsoft Office Project:And Microsoft Office Visio"  report generation features to create reports based on Project 2007 information.
Opening the Visual Reports Dialogue
To create a report using the Visual Reports feature, you must begin by displaying the Visual Reports dialogue box. To display the Visual Reports XE "Reports:Creating Visual Reports"  dialogue, click the Report menu, followed by the Visual Reports option.
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When you perform this action, you should see the following dialogue:
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Near the top of the dialogue you can use checkboxes to specify Excel report templates or Visio XE "Microsoft Office Project:And Microsoft Office Visio"  report templates. The templates for the application that you select will appear in the list of available templates beneath the tabs. 
You can use the tabs like a filter, to show only the templates that correspond to the selected tab’s label. In the image above, all Excel report generation templates are listed.

Choosing a Report
To choose a report from the dialogue, consider which tab contains templates that will reflect what you want to report. For example, if you want to report to show how the resources are being used in your project, you would choose the Resource Usage tab. 
When you select a tab, you will see a list of templates XE "Reports:Creating Visual Reports"  that fall under the selected tab’s heading.
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When you choose a tab, and then select a template by single clicking it, you will see a preview of the selected template in the Sample area of the dialogue.
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This preview does not reflect the actual project data, but it does indicate the general appearance, format, and style of the report. 
If the type of chart shown in the preview area is what you are looking for, double click the template icon where it appears in the dialogue, or click the View button in the bottom right of the dialogue. This will open the template up in Excel or Visio XE "Microsoft Office Project:And Microsoft Office Visio" .
Here, you can see the report in Excel XE "Microsoft Office Project:And Microsoft Office Excel" , showing resource work assigned and the resource work remaining for the project.
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The resulting PivotChart is created using the Excel XE "Microsoft Office Project:And Microsoft Office Excel"  report generation tools, based on the Project 2007 data. If you don’t know anything about Excel XE "Microsoft Office Project:And Microsoft Office Excel"  PivotTables or PivotCharts, don’t worry. For our purposes, it is enough to know that you can place checkmarks in the check boxes in the PivotTable XE "PivotTable"  field list (at the right of the Excel XE "Microsoft Office Project:And Microsoft Office Excel"  screen) to include the corresponding data in the report. (See the items circled in red in the image above.)
Experiment with the tabs in the Visual Reports dialogue and observe the previews of the templates in the sample area provided in the dialogue to get an idea of what your report options look like.

Editing a Report
To edit XE "Reports:Editing Visual Reports"  a visual report, first use the Visual Reports dialogue to select the most appropriate template for your report. 
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Once you have the report template chosen, click the Edit Template button in the dialogue to see a list of possible fields that you can add to the report data set.

Depending on which tab you choose in the Visual Reports dialogue, a corresponding data cube will be created that stores relevant data. (A cube can be thought of as a fancy kind of database that can contain multiple data elements from your project.)

When you click the Edit Template button, the particular information stored in the cube, as well as the information that has been selected (by default) from the cube for inclusion in the chosen template, will be displayed.
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This Field Picker dialogue XE "Reports:Using Field Picker dialogue"  (above) shows the information from your project that is stored in the data cube. The available information in the cube can vary, depending on what tab (template category) you choose. 
The Selected Fields area will display a list of the fields that will be available when you create your template. (These are the fields that you will be able to put a check next to in Excel to include them in your chart/report.)

In the Available Fields area, you will see a list of fields that are present in the cube, but are not selected for the template. 

You can move fields back and forth between the Available Fields area and the Selected Fields area by selecting them with your mouse (highlighting them) and then using the Add and Remove buttons to move them from one side to the other.
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Once you are finished specifying which fields will be available for you template, click the Edit Template button in the lower right of the field picker dialogue to create the template in its original application (Excel XE "Microsoft Office Project:And Microsoft Office Excel"  or Visio XE "Microsoft Office Project:And Microsoft Office Visio" ).
Creating a Template

You might have noticed that there is a New Template XE "Reports:Creating Visual Reports template"  button in the Visual Reports dialogue.
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If you click this button, you will see the following New Templates dialogue.
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In the top of the dialogue, you can use radio buttons to select the type of template that you want to create (Excel or Visio XE "Microsoft Office Project:And Microsoft Office Visio" ).
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In the next section of the dialogue, you can select the data type (the data cube that will be available) for the template. The drop list provided will display the same headings that are on the category tabs of the Visual Reports dialogue.
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The last section of the dialogue provides a button to access the Field Picker dialogue XE "Reports:Using Field Picker dialogue"  that was just discussed. (Remember, you can use the field picker to choose the fields that will be available in your template.)
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When you are ready to proceed, click the OK button in the lower right of the New Template dialogue to create the new template.

Here is the new template as it appears in Excel XE "Microsoft Office Project:And Microsoft Office Excel" .
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It contains an empty Pivot Table frame and a PivotTable XE "PivotTable"  field list containing the data elements that you chose to include. It is up to you to fill in the table and create the report as you see fit. You can save your new template to a specified location from within Excel XE "Microsoft Office Project:And Microsoft Office Excel"  if you wish (Office menu - Save As).

Modifying a Template

Whether you create your own new template, or use an existing template from the Visual Reports dialogue, you will probably want to modify the template to some degree. Applications like Excel XE "Microsoft Office Project:And Microsoft Office Excel"  and Visio XE "Microsoft Office Project:And Microsoft Office Visio"  give you a lot of control over the format, style, and overall appearance of your report. 

The ability to create slick professional looking Project reports, using the charting and report features of Excel XE "Microsoft Office Project:And Microsoft Office Excel"  and Visio XE "Microsoft Office Project:And Microsoft Office Visio" , is one of the key advantages to the new Visual Reports feature.

The following example demonstrates how your project report template can be modified XE "Reports:Modifying Visual Reports"  in Excel XE "Microsoft Office Project:And Microsoft Office Excel" . 

Once the template opens in Excel XE "Microsoft Office Project:And Microsoft Office Excel" , you can use the Pivot Table field list to choose the data that will appear in the report.
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Here, you can see that there is one field (Work) selected in the PivotTable XE "PivotTable"  field list. You will also notice that the Work is listed in the ∑ Values box in the lower right corner of the Excel XE "Microsoft Office Project:And Microsoft Office Excel"  screen. 
If you want to modify this chart by adding data to it, you can place checkmarks next to the fields that you want to add in the PivotTable XE "PivotTable"  field list, or you can use your mouse to drag fields from the PivotTable field list down to the ∑ Values box in the lower right. 

If you put a check mark next to the Remaining Availability field and another check next to the Actual Work field, our chart will now look like something like the following.
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Here is the same Excel XE "Microsoft Office Project:And Microsoft Office Excel"  chart with the Remaining Availability and Actual Work data added. The chart legend tells us that the darkest blue bars represent the scheduled work for the given resource, the light blue bars represent the actual work done at this point, and the other bars represent the remaining availability of the resource.

Now that we have the data that we want in our chart, it is time to polish its appearance. One easy way to do this is to click the Design tab in Excel XE "Microsoft Office Project:And Microsoft Office Excel"  (remember, we are working with an Excel XE "Microsoft Office Project:And Microsoft Office Excel"  2007 template in this example).
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This will show a series of options that you can quickly use to modify your chart. Under the Chart Styles area, you will see a selection of preset color and formatting choices for your chart. This is probably the easiest and quickest way to give your report a slick appearance.
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You can click the small arrows at the left of the Chart Styles buttons to see more chart style options.
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All that you have to do is to click on the style that you like the most to apply it to your report. Here is the same chart after using the Excel XE "Microsoft Office Project:And Microsoft Office Excel"  Design and Layout options to modify it. 
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If you are using Excel XE "Microsoft Office Project:And Microsoft Office Excel"  to modify your chart, you will find a series of tabs at the bottom of the Excel XE "Microsoft Office Project:And Microsoft Office Excel"  screen. 
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If you click the Data tab, you will see a table containing the actual report data used for your Visual Report. Once again, there will be a number of options available for modifying the appearance of the report.
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You will recall that when you create a template in Visual Reports using Excel XE "Microsoft Office Project:And Microsoft Office Excel" , you will see something called an empty PivotTable XE "PivotTable"  frame.
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The sections of the table frame will have labels like “Drop Row Fields Here” and “Drop Data Items Here.”
To turn this empty frame into a report, drag the appropriate fields from the field list into the table frame sections. For example, to see the actual work done by the resources, you could drag the resources field from the field list to the Drop Row Fields Here section, drag the Time field to the Drop Column Fields Here section, and drag the Actual Work field to the Drop Data Items Here section. 
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Now the table frame is populated with data.

 Once you get this far, you can use the powerful Excel XE "Microsoft Office Project:And Microsoft Office Excel"  charting and report generation options to modify your table or even create a custom chart based on it.

[image: image324.png]A C ) E F G H J K

B Actual work  vearl
Pl Resources [ ©2008 Grand Total

s  —

s

s

8

Ell Grand Total 570.4 570.4]

10

n

1

13

1

15 o _ _
5 E 0§ E F O} %
? & E z £ 5 2
18 F] £ 3 2 i £
1 §EF : F 2 5
20 £





You can print out these reports and charts from within Excel XE "Microsoft Office Project:And Microsoft Office Excel" , or you can save this template for future use by clicking the Office menu, followed by the Save As option.
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In the Save As dialogue, make sure that you save the file as a template.
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When you click the Save button, you may see an alert like the following.
[image: image327.png]M ‘This workbook contains external data. Do you want Microsoft Office Excel to clear the data before saving the:
B e e e e

= J|Cw ] (o)





This alert is asking you if you want to include the current Project data in the template. If you want to reuse this template for a number of different projects, click Yes, so the data will be automatically refreshed when the template opens.
Now from within Project 2007 you can re-use this template with a different set of project data. First, display the Visual Reports dialogue and put a check in the “Include report templates from” check box.
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If you click the Modify button, you will be able to browse to the folder that you saved your new template or templates in.

The newly created template will now be included in the dialogue’s list of available templates.
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If you double click on the newly created template, or select it and click the View button, Visual Reports will now open the template with data from the current project.
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Lesson 4.3: Saving Cube Data

In the preceding lesson, we mentioned that Visual Reports saved the Project data in a fancy data base structure called a cube. This data was then used by an Excel XE "Microsoft Office Project:And Microsoft Office Excel"  or Visio XE "Microsoft Office Project:And Microsoft Office Visio"  template to create a report that can be modified with Excel XE "Microsoft Office Project:And Microsoft Office Excel"  or Visio XE "Microsoft Office Project:And Microsoft Office Visio"  formatting and style tools.

There can be other uses for these data cubes, also known as OLAP (OnLine Analytical Processing) cubes, besides transferring data to Excel XE "Microsoft Office Project:And Microsoft Office Excel"  or Visio XE "Microsoft Office Project:And Microsoft Office Visio" . For one, they can be used instead of a traditional database; moreover, they can be faster in certain instances than traditional relational databases. This lesson deals with saving your Project data in the OLAP cube form.
Choosing the OLAP Cube
If you would like to save your project data as an OLAP cube XE "Saving Data as OLAP Cube" , you must display the Visual Reports Dialogue by clicking Report, followed by Visual Reports.
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When the dialogue appears, click the Save Data button near the bottom of the dialogue.
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When you click this button, you will see the following Save Reporting Data dialogue:
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To choose the type of cube you want to save, simply select an option from the Save Reporting Cube XE "Reports:And OLAP"  drop list.
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Using the Field Picker
You have already seen the Field Picker in the previous lesson on generating Visual Reports. It should come as no surprise that you can use the Field Picker to refine what data will be stored in your OLAP cube.

Once you have selected a cube type, click the Field Picker button to display the Field Picker dialogue XE "Reports:Using Field Picker dialogue" .
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In the Field Picker, select the fields that you want to add from the Available Fields list. Then, click the Add button to add the selected field to the Selected Fields list.

Similarly, you can remove a field from the selected fields list by selecting (highlighting) it, and then clicking the Remove button. If you want to empty the selected fields list to start fresh, just click the Remove All button. When you remove fields from the Selected Fields list, they will appear in the Available fields list.

The fields in the Selected Fields list are the fields that will be saved in the OLAP cube.

Saving the Cube
After you have picked a cube type and have selected your fields with the Field Picker, you can save your cube by clicking the Save Cube button.
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When you click this button, you will see a Save As dialogue like the following.
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Use the navigation controls to choose a folder for your cube, and then click the Save button to save the cube in the folder that you specified.

Saving a Database
You can also save a database containing all of the reporting information for your Project. To do this, just click the Save Database XE "Reports:Saving as database"  button in the Save Reporting Data dialogue.
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When you click this button, you will see a Save As dialogue like the following.
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Once again, use the navigation controls to select a folder for your database, enter a name in the File name field, and click the Save button to save your database in the specified location.

Lesson 4.4: Using Other Reports

Believe it or not, there are still more ways to create reports in Project 2007. In this final lesson on reports, you will learn about the Copy Picture feature, and you will learn how to create a report using the Project Guide.

Using the Copy Picture Feature
Project provides an interesting feature for presenting a report based on the current Project screen view. To create this kind of report, click the Report menu, followed by the Copy Picture XE "Reports:Copy Picture"  option.
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When you choose the Copy Picture option, you will see the Copy Picture dialogue appear on your screen.

[image: image342.png]Copy Picture

Render image

[Ororsaeen

(© Forprter

O 70 GrF magefe
Ci\PracticeExerciseintdsav. gif

copy

(© Rows on screen
O selected rows

Timescale
(@ As shown on screen
Ofroms [Tee 1/1j08 ] 1o [T a3





In the first set of radio buttons in the dialogue, you can make the following selections:

· For Screen
· For Printer

· To GIF image

If you choose the For Screen radio button, an image of the current Project view will be stored in memory (clipboard). You can then paste this image into another program, like Microsoft Word.

If you choose the For Printer button, you will be able to print out an image of your current Project view. You can preview the print-out in the Print Preview XE "Print Preview"  window.

If you specify To GIF image, you will be able to save the current project view as an image in a folder on your computer. If you select this option, you can use the Browse button to navigate to the folder that you want to save the image in.
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When you click the Browse button, a Save In dialogue will appear.

You can also refine the content of the image by using the Rows on Screen or Selected Rows radio buttons.

[image: image344.png]@ TaskName Duration | Start L= copy picture

Render image
@ For sereen
OFor printer
O To GIF image file:

[4 Creste documertation Thu 2121108

[ Revise documertaion 3deys Tueansms Thuaniil

[E] | Print Documentation ahs Tuean2ms

[ | Release Softwaretousers Tk Tue 42208 Set 4250 O pogs on screen
[ MectngPrepardtion ey | e 22708 e 2278 [ selctdtons |
[ Meetwih President T Teaime T S

[ Finel Meeting wih Programers b Thuanops Thaanon)

[ as shown on screen
(Orom: [Th 3/s/o8 ] 1o; [sun4ie8

Ceaee J





If you choose Selected Rows, only the rows that have been selected in Project will be included in the created image. If you choose Rows on Screen, all visible rows will be included.

You can also choose to use the timescale shown on screen in your image, or you can choose to specify a range between particular dates for your image. These options are selected with the dialogue’s bottom two radio buttons (under the Timescale heading).
When you have configured your copied image options as you wish, click the OK button at the bottom of the dialogue to create the image.
Here is the Print Preview XE "Print Preview"  window for a Project view that was copied for the Printer. Clicking the Print button in the preview window will allow you to print the report.
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This picture shows a report that was pasted into Microsoft Word after using the For Screen option in the Copy Picture dialogue.
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Using the Copy Picture to Office Wizard XE "Reports:Copy Picture to Office Wizard" 
If you would like to prepare a report for your project using a program like Word, or Power point, you can use the Copy Picture to Office Wizard XE "Reports:Copy Picture to Office Wizard"  to incorporate images of your project views.

To take advantage of this option, click the Copy Picture to Office Wizard XE "Reports:Copy Picture to Office Wizard"  button on the Analysis toolbar.
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If this toolbar is not visible on your Project screen, choose View - Toolbars - Analysis to display it.
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When you click the Copy Wizard button on the Analysis toolbar, the following wizard dialogue will appear.

[image: image349.png]Copy Picture to Office Wizard - Information,
Welcome to the Copy Picture to Office Wizard
This wizard helps you dislay information fram Microsaft Ofice Project in @ new PawerPoin,
Word, or Visio document.

The data diplayed inthe generated Office System document incudes an image of the active
view n your project, and any project-level fieds you choose to export;

To create a PowerPeintWordisio document, you must have PowerPaintjWord/iisio 2000 or
later nstaliec on your cormputer.

To continue, cick Next





 The first thing to do is click the Next button.
[image: image350.png]Copy Picture to Office Wizard - Step 1 of 4,

Select an Outline Level

Vou can chaose ta keep your current project's autine leve setting, or madfy the level using
this wizard. The outline level setting defines the level of summary tasks and subtasks thet
vou display in the new Office System document.

Important If you choose to modify the outline level for the new Office:
document, the outline levelin your original project fle s also updated.

(@ Keep my original outine level
O Modfy my outine level





In this step of the wizard, you can specify an outline level for the report image. The outline level specifies what summary or sub tasks will be shown. To keep your original outline level, select the corresponding radio button. To modify the outline level, select the Modify my Outline level radio button, put a checkmark in the Show checkbox, and choose an outline level from the drop list.

When you are ready, click Next to move to the next step in the wizard.
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In Step 2 of the wizard, you can choose to include only selected rows of information or to include all of the rows on screen or in the current view. You can also specify a range of time for your report, and choose a Default, Maximum, or Custom image size for the report.

When you have configured the radio buttons as you wish, click the Next button to move to step 3 of the wizard.
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In step 3 of the wizard, you can preview the report image with the Preview button.

If you are happy with the report, use the Application radio buttons to specify what application the report is destined for. Finally, you can choose between Portrait and Landscape for your report orientation.

When you are ready, click Next to move onto the final stage of the wizard.
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In the last stage of the wizard, arrange the Project fields that you want to display with your report, and click the Finish button to create a GIF image of your report.
If, at any time before you click the Finish button, you want to make changes to your settings, just click the Back button to step back through the stages of the wizard.

Creating a Report with the Project Guide
If you click the Report XE "Reports:And Project Guide"  option in the Project Guide toolbar, you will see a Report Project Guide pane appear on the left of the Project screen.
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You can use the hyperlinks in the task pane to select a view or report, arrange the information in a view, print the current view as a report, and more. 

If you click the small down pointing arrow next to the Report button on the Project guide task bar, you will see a list of the same options as provided in the hyperlinks.
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If you choose an option from this list, the corresponding Project guide pane will be displayed. For example, if you select the “Print current view as a report” option (fourth from the top), you will see the following pane appear on the left.
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You can now simply choose the options that you want to apply in the pane and click the hyperlink at the bottom to continue to the next step in the process.
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In the next step, you can specify the particular aspects of your report that you want to change. Depending on which radio button you select, you will be provided with a hyperlink to the required options needed to make the changes you are looking for.
In step 3 of the wizard, you will see options for adding headers and footers to your report.

(You may recall that this process was discussed in Lessons 4.3 and 4.4 of the Foundation manual.) 
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In step 4 of the wizard, you can access options to modify the margins, print notes, configure page breaks, and more.
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You might have noticed that at any stage of the process, the Print Preview XE "Print Preview"  and Print buttons are available at the bottom of the pane. This means that at any stage in the process, you can view what your project report looks like and print it at that stage if you wish. There is also normally a Go Back to Previous Stage hyperlink available for moving back through the stages.

This is the print preview window obtained by clicking the Print Preview XE "Print Preview"  button at stage 2 of the Project Guide. 
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You can also display the Visual Reports or standard Report dialogues from the Project Guide. To do this, select the first option from the Project Guide Report menu.
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In the resulting pane, select the radio button labeled “Create a project report.”
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This will display two hyperlinks, Display Visual Reports and Display Reports. The first (Display Visual Reports) will invoke the Visual Reports dialogue. The second (Display Reports) will invoke the standard Reports dialogue.

Creating a Report from a View with the Project Guide
In the Views and Reports pane shown above, you can also select the “Display or analyze project information with a view” radio button.  XE "Reports:And Project Guide" 
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This will display a list of views in the Pane that you can choose from. Below the list, you will see a description of the list item that is selected. To apply this view to your project, click the “Apply this view” button. Once the view is applied, click the “Print current view as a report” option from under the Project Guide Report menu.

[image: image364.png]Report

Select a view or report
Changs the content or order of nformation in  view

Changs the lock or content of the Gantt Chart

Print curent view as areport

Seo the statusof mulile projecta Project Certer
Compare progress against baselne work

See the projects crtical tasks

See project risks and ssues

See how resourcestne s alocated

See project costs

Publish project information to the Web.





Clicking this option will display the Print Current View pane.  XE "Reports:Creating from current view" 
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As mentioned before, you can click the hyperlinks at the bottom of the Pane to proceed further on to other Panes in the report creation process. Alternatively, you can click Print Preview XE "Print Preview"  or Print to view or print out the report at any time.
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Section 4: Review Questions


1. The Visual Reports feature works by… 
A. Using the Report/Chart tools of other applications
B. Using report data from your project stored in an OLAP cube
C. Creating reports in Visio XE "Microsoft Office Project:And Microsoft Office Visio"  2007 or Excel XE "Microsoft Office Project:And Microsoft Office Excel"  2007 with Project 2007 data
D. All of the above
2. To use a pre defined report type you can choose...
A. Report - Reports
B. Report - Pre-sets
C. Visual Reports - Pre-sets
D. None of the above
3. Which one of the following is not an option in the Reports dialogue?
A. Overview
B. Costs
C. Tasks
D. Workload
4. OLAP stands for…
A. Online analytical processing
B. Overlap 
C. Online assignment processing
D. None of the above
5. Which of the following statements is true?
A. You can use Visual Reports to save reporting data as an Oracle database
B. You can use Visual Reports to save reporting data as an Access XE "Microsoft Office Project:And Microsoft Office Access"  database
C. A relational database is the same as an OLAP cube
D. You cannot save report data as a database
6. To use Visual Reports you need…
A. Project 2007 
B. Project 2007
C. Project 2007 and Excel XE "Microsoft Office Project:And Microsoft Office Excel"  2007 Visio XE "Microsoft Office Project:And Microsoft Office Visio"  2007
D. Any of the above
7. You can save a report created with Visual Reports and Excel XE "Microsoft Office Project:And Microsoft Office Excel"  as a(n)… 
A. Workbook
B. Template
C. Excel XE "Microsoft Office Project:And Microsoft Office Excel"  98-2007 workbook
D. Any of the above
8. You can modify the Margins, Headers, and Footers of a report with the…
A. Print dialogue
B. Page Setup dialogue
C. File menu
D. None of the above
9. Print Preview XE "Print Preview"  is available from the…
A. File menu
B. Page Setup dialogue
C. Print dialogue
D. All of the above
10. To modify a report in Excel XE "Microsoft Office Project:And Microsoft Office Excel"  2007, you should use the… 
A. Design ribbon
B. Formulas ribbon
C. View ribbon
D. None of the above
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Remove Split command
39

Split command
38

Split Command
40

Unhide command
37






Work / Resource Units = Duration





Resource Units X Duration = Work











































































































































































































Task Duration = Total Work / Resource Units








Resource Units x Duration = Work
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Work / Resource Units= Duration








Work / 2 Resource Units= Duration

















Duration = Work/ Units
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